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1

Introduction to Aurical FreeFit and the Probe
Microphone Measurements (PMM) module

1.1

Aurical FreeFit and Probe Microphone Measurements (PMM)

1.1.1

Brief description
FreeFit is a desktop or wall-mounted advanced 4-channel frequency analyzer for probe microphone measurements. It wirelessly transfers measurement data via Bluetooth to a PC with
the Otosuite Probe Microphone Measurements (PMM) module installed.
You use the Otosuite PMM module to operate FreeFit.

Aurical FreeFit shall only be charged using the type 1053 charger unit or the type 1081
AURICAL speaker unit from Natus. This manual describes the assembly and use of the type
1053 charger unit. If you use the Aurical speaker unit to charge your FreeFit, see the manual
for Aurical Aud.
FreeFit can also be used with the Otosuite Counseling and Simulations module.

FreeFit cannot be used without Otosuite. When you have set up FreeFit for testing, install
the relevant software on your PC. When the PC application has been installed, run the Configuration Wizard and configure PMM. You are now able to connect to FreeFit. If you are
going to use FreeFit with Speech Mapping, you must also configure the Counseling and Simulations module.
PMM and FreeFit integrate closely with the Natus audiometers by offering real time presentation of test results and full
test control directly from a PC with a comprehensive user interface.

1.1.2

Physical operating principle
Aurical® FreeFit uses loudspeakers to generate reference sound pressures. By placing built-in microphones close to a
patient’s eardrums as well as outside the ears, the four channels are used for measuring the sound pressure level at the
eardrum as well as outside the ear for both ears simultaneously. In this way, FreeFit and the PMM module enable you to
perform true binaural measurements that provide you with valuable information when you adjust hearing instrument settings in the suppliers’ fitting software.

1.2

Aurical FreeFit interfacing with PMM
PMM is designed to operate with Aurical FreeFit as the test device.
Aurical FreeFit is controlled directly from the PMM or the Counseling and Simulations module.
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1.2.1

Bluetooth
FreeFit connects with Otosuite via BluetoothTM. Bluetooth is a wireless communication standard, which allows devices
such as computers, PDAs, mobile phones and headsets to communicate and send data to each other in real-time, without
the need for wires or cables to link together the devices. Devices can typically communicate at ranges of up to 10 metres
(approx. 33 ft.).

1.3

Intended use
Intended Users: Aurical Freefit and PMM are intended for audiologists, hearing instrument dispensers, ENTs, speech therapists and other health care professionals.
Intended User population: The intended User population is all patient groups from 2 weeks of age through adulthood.
Intended Use: to visualize the amplified signal recorded in the ear(s) of persons with a hearing loss together with reference
information such as target curves in order for the user to have an objective basis for adjusting the hearing instrument settings. Note also that Aurical FreeFit is designed for use in combination with NOAHLink - HIMSA’s wireless hearing instrument programming device. See Fitting FreeFit with NOAHlink ► 101.
User environment: The device is intended for use in clinics, institutions, hearing aid dispenser office. The device is intended for use in a quiet environment within normal office temperature/humidity/pressure ranges and lighting conditions.

Clinical Benefit
1053 Aurical FreeFit is used to conduct Probe Microphone Measurements (PMM) to measure the sound pressure level in
the ear canal, and deliver stimulus for measurement of Real Ear to Coupler Difference (RECD), thereby providing a basis for
objective hearing aid verification.

1.4

About this manual
This is your reference manual to installing, calibrating and using Aurical FreeFit and to using PMM. It also introduces you to
the key features of the device and the software, as well as to working scenarios for performing tests and viewing and printing test results.

Note • If you are using Otosuite with Noah, we recommend that you be familiar with the screens and functions
provided in Noah.

Note • For information about the Counseling and Simulations software, see the manual for Aurical Visible Speech and
the Counseling and Simulations Module.

After you install Otosuite, you can find Otosuite manuals and related documentation on your PC. In the Start menu, open
Otosuite Manuals, which contains an overview with links to all manuals.

Aurical FreeFit
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1.4.1

Installation and Assembly
Unpacking FreeFit ► 90 and Assembling FreeFit and the FreeFit charger and ear probes ► 95 contain a full description of
unpacking instructions, and how to assemble the device.
If you use the AURICAL speaker unit to charge your FreeFit, see the manual for Aurical® Aud, Unpacking and Installing, and
Aurical® Aud with Hi-Pro.
For instructions on installing the software, see the Otosuite manual.

1.4.2

Safety
This manual contains information which must be followed to ensure the safe performance of Aurical FreeFit. Local government rules and regulations, if applicable, should also be followed at all times.
Safety information is stated where it is relevant, and general safety aspects are described in Safety - Aurical FreeFit and
PMM ► 111.
If you use the AURICAL speaker unit to charge your Aurical FreeFit, see the Aurical® Aud manual, Standards and Safety.

1.4.3

Training
It is recommended that you read this manual and try out test scenarios before you start operating Aurical FreeFit so that
you are familiar with both the device and the software before testing a patient.

1.5

Typographical conventions
The use of Warning, Caution and Note
To draw your attention to information regarding safe and appropriate use of the device or software, the manual uses precautionary statements as follows:

Warning • Indicates that there is a risk of death or serious injury to the user or patient.

Caution • Indicates that there is a risk of injury to the user or patient or risk of damage to data or the device.

Note • Indicates that you should take special notice.

1.5.1

Navigation
Menus, icons and functions to select are shown in bold type, as for instance in:
•

9

Click the Set options icon on the toolbar or select Tools > Options...
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Powering FreeFit and connecting Aurical FreeFit and
PMM

2.1

Powering FreeFit
Device
•

FreeFit is powered by a battery. See Batteries ► 12.

Charger
•

The FreeFit charger is connected to a power supply, which is connected to the electrical power outlet. See Powering
the charger ► 11.

It is recommended that you leave FreeFit in the charger when you are not using it so that the device is always ready for
use.

2.2

Powering the charger
Note • This manual describes the assembly and use of the type 1053 charger unit. If you use the AURICAL speaker unit
to charge your FreeFit, see the manual for Aurical® Aud.

The FreeFit charger is delivered with a power adapter and a Y-splitter cable that can be attached to the power supply. This
allows you to charge both FreeFit and NOAHlink at the same time with a single power supply.

Warning • Use only the power supplies specified in Technical specifications, Power supply. See Technical Specifications - Aurical FreeFit ► 121.

1. If you want to charge the NOAHlink at the same time as FreeFit,
connect the Y-splitter cable to the power supply. Insert the plug
labeled “To FreeFit” into the FreeFit charger.
If you are not using the NOAHlink, connect the power supply (A)
with the charger without using the Y-splitter cable.

A. Power supply

2. Select the appropriate mains supply adapter from power supply kit
supplied with FreeFit to fit your mains outlet. Slide the plug
adapter onto the mains supply until it clicks.
3. Plug the power supply into a mains power outlet. When you
switch on power to the charger, the green power indicator on the
charger front is lit.

Aurical FreeFit
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2.3

Switching off the charger
To switch off the charger, unplug the power supply from the mains power outlet, or switch off the power outlet.

Warning • Electrical equipment must be positioned so that there is easy access to disconnect the power supply
from the mains.

2.4

Batteries
Caution • Use only the battery types listed in Technical Specifications - Aurical FreeFit ► 121.

NiMH rechargeable batteries
FreeFit is delivered with a rechargeable NiMH battery. Before you can operate FreeFit, insert the battery into FreeFit. See
Inserting the battery ► 12

Note • Replace rechargeable battery every year. New batteries must be purchased from Natus.

First time charging
Charging applies only if you use a rechargeable battery.
The rechargeable NiMH battery may not be fully charged when you receive FreeFit. You should charge the battery for
some hours, and preferably overnight, before you switch on FreeFit.
A fully discharged battery must be charged in the FreeFitcharger for 14 hours before it is fully charged.
A new rechargeable battery may not reach full capacity until it has been recharged a couple of times.

Alkaline batteries
If required, FreeFit can be powered by a non-chargeable Alkaline battery.

Warning • If you are using an alkaline battery, do not attempt to charge your Aurical FreeFit. Your alkaline battery may be damaged and leak, and this may in turn cause damage to Aurical FreeFit. Place FreeFit in the charger
unit only if Aurical FreeFit contains a rechargeable battery.

2.5

Inserting the battery
1. Remove FreeFit from the charger.

12
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2. To insert the battery,
press the grooved area
(A) on the front of the
battery cover at the top
of FreeFit and gently tip
the lid backwards off the
compartment.
3. Insert the battery as
shown below. A label
inside the battery compartment shows which
way the battery fits.

4. Put the battery cover
back in place.

2.6

Switching FreeFit on or off
Switching on Aurical FreeFit
Press and hold the power button on top of the device until the status indicator light turns on. The status indicator will
light for about 3 seconds, and then go into periodic flashing.
The various light indications are described in Charging, powering and connection status ► 14.

Switching off Aurical FreeFit
Press and hold the power button on top of the device until the status indicator light turns off.

A. Power button

Aurical FreeFit
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2.7

Charging, powering and connection status
We recommend that you place FreeFit on the charger when it is not in use. This will ensure that the batteries are always
charged, and the charger is a convenient cradle for FreeFit.

Warning • Unless you are charging Aurical FreeFit with the Aurical® Aud speaker unit, which has a medically isolated power supply unit, do not attempt to use Aurical FreeFit with patients while it is placed in the charger unit.

The status indicator changes color to indicate the powering and charging state of the FreeFit.

A. Status indicator

The indicator can show one steady color, one flashing color, or alternating colors to provide additional information.

2.7.1

Charging and battery status
Note • If the indicator status is flashing with two or more alternating colors, see the descriptions for both colors.

Amber, steady
•

FreeFit is turned off and charging.
Note that charging is automatically discontinued after 14 hours of charging. This is done to ensure that batteries are
not being over-charged.

Amber, flashing (alternating with another color)
•

In the charger: FreeFit is turned on and charging.

•

Off the charger: FreeFit is turned on but the battery status is low. FreeFit can be used in this mode for a period of
time, but needs to be recharged or fitted with a new Alkaline battery as soon as possible.

Green, steady

14

Aurical FreeFit

2 Powering FreeFit and connecting Aurical FreeFit and PMM

•

FreeFit is not charging, and is turned off.
FreeFit enters this state after 14 hours of continuous charging or if an Alkaline battery has been detected.
Note that charging is resumed if the device is removed and then placed on the charger again.

Red, flashing (faster than every 2 seconds)
•

In the charger: An error has occurred in FreeFit during charging.
Most likely, the battery is defective. Replace the battery and try charging again. If the error continues, contact your
supplier.

“Battery low” indication in PMM
When a battery low state is detected in FreeFit , this is signalled by the FreeFit status indicator with the amber color
described in Amber, flashing (alternating with another color) ► 14.
If FreeFit is connected to PMM, a “Battery low” indication is shown in the bottom right corner of the screen. Also, a
bubble notification will appear.
When the “Battery low” warning occurs, there will be approximately ½ hour of continuous use left. The time left will, however, vary depending on how FreeFit is used, and the state of the battery. If the rechargeable battery is fairly old, the time
left will be shorter than for a new battery.

Note • For Alkaline batteries, the “Battery low” indication may not leave as much testing time as a rechargeable battery would.

2.7.2

Connection status
Note • If the indicator status is flashing with two or more alternating colors, see the descriptions for both colors.

Green, flashing (every 2 seconds)
•

In the charger: FreeFit is not charging, and a Bluetooth connection with Otosuite has been established.

•

Out of the charger: FreeFit is turned on but not connected.

Green, flashing (faster than every 2 seconds)
•

In the charger: FreeFit is not charging, and FreeFit is communicating with Otosuite.

Blue, flashing (every 2 seconds)
•

FreeFit is turned on and a Bluetooth connection with Otosuite has been established. Battery status is OK.

Blue, flashing (faster than every 2 seconds)
•

Aurical FreeFit

FreeFit is turned on and is communicating with Otosuite. Battery status is OK.
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Red, flashing (faster than every 2 seconds)
•

Out of the charger: An error has occurred in FreeFit. Wait for the unit to power off automatically or remove the battery to turn off FreeFit. Power on FreeFit again. If the error continues, contact your supplier.

Red, flashing (every 2 seconds)
•

2.8

FreeFit has a Bluetooth initiation error. Press the power button or remove the battery to turn off the unit. Power on
the unit again. If the error continues, contact your supplier.

Establishing a connection between FreeFit and PMM
When you use PMM for the first time, run the configuration wizard to set up the connection between Aurical FreeFit and
PMM.. See Configuring PMM ► 105.

2.8.1

Connecting to FreeFit
After you have configured PMM for the first time, if FreeFit is turned on when you open the Control Panel in PMM, then
FreeFit will connect to PMM automatically. Otherwise, you can connect FreeFit as follows:
1. Turn on FreeFit.
2. In PMM, on the toolbar, click Control Panel.
3. In the control panel, click Connect.
The Control Panel relating to the test device and the selected test type is shown in the left side of the screen.

Firmware update - FreeFit
If your Otosuite has been updated and a new Firmware update has become available, a message will appear.
Follow the on-screen instructions.

2.8.2

Reconnecting to a test device
If the control panel for a test type is shown, and communication with the selected test device is interrupted, a message
appears stating that there is no longer connection to the device.
•

Click the Connect button on the control panel to reconnect to the last-used test device.

•

Alternatively, you can run the configuration wizard to select a different device, if one is available. See Configuring
PMM ► 105.

FreeFit transmits test data to PMM when communication is active. Since FreeFit does not have any storage capability, you
may lose data if communication is interrupted. Run the test once more, if necessary.
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Preparing FreeFit and PMM for testing
It is important to prepare properly before making measurements with FreeFit and PMM. It is time-saving for both you and
the patient if the environment, the patient, the FreeFit, and the program are ready for the test.
Before you start, make sure that the test environment is conducive to testing. This includes factors such as selecting a test
location where environmental influence on test results is minimal, and setting up equipment such as speakers, FreeFit and
computers. It is also important that you familiarize yourself with FreeFit and PMM before your first session.

3.1

3.2

Preparing for a test session with FreeFit and PMM
•

Make sure the cables of the test equipment are connected correctly. See Setting up audio equipment for use with
PMM ► 1.

•

If you are using the AURICAL speaker unit, then ensure that it is plugged in before you turn on the PC.

•

Launch Otosuite and PMM on the PC. See the Otosuite manual.

•

Switch on FreeFit. See Switching FreeFit on or off ► 13

•

Check the battery status of FreeFit to make sure that the device is ready for testing. See Charging, powering and connection status ► 14.

•

Make sure the connection between PMM and FreeFit is enabled. See Establishing a connection between FreeFit and
PMM ► 16.

•

Fit silicone test tubes to the probes you will be using. See Fitting silicone test tubes on the probes ► 99.

•

Perform a room calibration if changes have been made to the test environment. See Performing a room calibration ►
17.

•

Perform a tube calibration if you have fitted FreeFit with new silicone test tubes. See Calibrating the probe tubes ►
18.

Performing a room calibration
Traditional speaker calibration adjusts the level of the signal delivered by the speakers. Room calibration adjusts the sound
spectrum to take speaker and room characteristics into account in order to play back signals reliably in the sound field.
It is important to recalibrate the speaker system at frequent intervals. Depending on the calibration frequency option that
was selected last time a room calibration was performed, you will receive a reminder to perform a room calibration when
a day, week or month has elapsed since the last calibration. In addition, you should run a room calibration if you make
changes to the physical environment where you use FreeFit, such as changes to the layout of the room or the placement of
the patient.
To perform a room calibration:
1. Select Tools > FreeFit Calibration > Room to open the Room Calibration wizard.
2. Select the frequency at which you would like to be reminded to perform room calibration. Click Next.
3. If FreeFit is not turned on, press the power button on the device. In the wizard, select the “My FreeFit is turned on
and within reach” check box.
4. Before you start the calibration, position the FreeFit probes in the intended client location, preferably correctly
placed on your shoulders, with the probes on your ears.
This will take into account the influence of a person being placed in the sound field.
5. Click Next.
The speaker calibration results for the front speaker are displayed.

Aurical FreeFit
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If an error message appears, one of the probes may be disconnected or faulty, or the probes may be positioned asymmetrically to the speaker. Check that both probes are connected properly, and that they are both the same distance
from the speaker.
6. If you have configured a rear speaker for use in FreeStyle, click Next to calibrate the rear speaker.
7. Click Finish to close the wizard.

Note • To stop the calibration, press ESC.

3.2.1

Reference microphone calibration
Reference microphone calibration must only be performed by a authorized service technician.

3.3

Calibrating the probe tubes
It is recommended that you perform a tube calibration whenever you change silicone test tubes on the probe. The purpose is to calibrate the acoustic influence of the individual tubes to the frequency response.
1. Fit a new probe tube on the probe. See Fitting silicone test tubes on the probes ► 99.
2. Insert the free end of the probe tube in the test location on the probe.

A. Probe tube
B. Test location for probe tube calibration

3. Make sure that Aurical FreeFit is connected to PMM.
4. Press the power button briefly on Aurical FreeFit.
The Probe Tube Calibration dialog box appears and the calibration starts automatically.
Alternatively, launch the wizard with the toolbar icon. In RECD, pressing the power button starts an ear
measurement.
The calibration sounds are played through the loudspeaker. The calibration is shown on the screen as it progresses and
stops automatically.
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If the tube calibration fails
Tube calibration may fail due to noise or to unstable signal conditions, for example if the probe tubes are occluded or not
mounted correctly on the probe, or if the probe tubes are touching another object, such as the client’s clothing. If you
recieve an error message, try to eliminate sources of ambient noise, and ensure nothing is touching the probe tubes.

Using the AURICAL HIT speaker
If you select the Use AURICAL HIT speaker option in the Probe Tube Calibration dialog box, you can use the speaker
inside the Aurical® HIT test chamber for the probe tube calibration. This option is only visible if an Aurical® HIT device is
connected to Otosuite. Open the Aurical® HIT test chamber and hold FreeFit in front of the speaker, and then click the
Start button in the Probe Tube Calibration dialog box.

Calibrating at the beginning of each new session
If you select the Show for new client option, the dialog will open at the beginning of every client session. The setting will
not be saved for future sessions unless you save your settings in the Options window. For more information about saving
default settings and user tests, see the section "Getting started with Otosuite" in the Otosuite manual.

3.4

Preparing the patient
In order to prepare the patient for probe microphone measurements, you must:
•

Position the client so that the sound field will not be blocked during measurements.

•

Prepare the client for insertion of the probe tubes.

•

Fit FreeFit and probes on the patient.

Note • For best results, we recommend replacing the original ear cords with ear hooks, which offer a more stable
placement of the probes and probe tubes. For instructions on mounting the ear hooks, see Attaching an ear hook to
the probe ► 86.

3.4.1

Positioning the client
A quiet environment is necessary for accurate measurements. SeeRequirements to the location ► 89
1. Place the client as shown in Positioning test equipment ► 1. The client should be approximately 1 m (3 ft) from the
speaker(s).
2. Position the client so that you can easily access the client’s ear(s).
The client must not be wearing hearing instruments while the probe tubes are being inserted.

3.4.2

Preparing to insert the probe tubes
Hygienic precautions
It is important that hygienic precautions are taken to protect the client from cross-infection.

Aurical FreeFit

•

Be sure to follow any established infection control procedures for the setting in which you are working.

•

To prevent cross-infection, use new silicone probe tubes for each client.
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Inspecting the client’s ears
Grasp the pinna and gently pull it back and slightly up and away from the client's head.
1. Inspect the ear canal and make sure that you can see the ear drum. Ensure that the ear drum is intact and that the client’s ear canals are neither inflamed nor irritated.
A perforated ear drum also will affect the measurement results.
2. If you can see apparent narrowing of the ear canal, it may be blocked by ear wax or debris, or it may not be straight. If
the ear canal is blocked, for instance by ear wax or debris, the outcome of the procedures may be affected.
Clean the ear canal if required.

QuickView - Live Otoscopy in PMM
If you have an Otocam device, you can open a live otoscopy window on top of the PMM window. This can be useful in
order to monitor the placement of the probe tube, for example.
1. Click the Show Live Video Otoscopy icon in the PMM tool bar to open the QuickView video otoscopy
window.
A. Button for closing the window
B. Grabber for resizing the window

You can also use the buttons on Otocam to turn on Otocam and open the window, or turn off Otocam
and close the window.
For more information, see the Otocam Reference Manual.
Note that this on-top function allows you to view live video only, and you cannot store or annotate images.

3.4.3

Fitting FreeFit and probes on the client
1. Place FreeFit on the patient’s shoulders. If you are using a NOAHlink fitting device, place it
around the patient’s neck.
2. Place the ear cords or ear hooks with the probes over the ears of the patient. Adjust the
length of the ear cords or ear hooks, if required. Make sure that you use new probe tubes.
3. If you have not already calibrated the probe tubes, then calibrate them now. See Calibrating the probe tubes ► 18.
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4. Insert the probe tube into the probe tube guide. Adjust the probe tube guide so that it
rests directly outside the opening of the ear canal. The optimal height of the probe tube
guide depends on the angle of the ear canal.

3.4.4

Inserting the probe tubes
An accurate placement of the probe tubes is essential for accurate PMM measurements.
For adults and children 16 years and older, it is recommended to use the ProbeTube Assistant in Otosuite to assist you
with positioning the probe tubes. Alternatively, you can place the tubes based on recommended distances.

Using the ProbeTube Assistant to assist in probe tube placement

Caution • The ProbeTube Assistant has not been validated for use on children under 16 years of age.

Note • The ProbeTube Assistant can only be used for placing probe tubes in unoccluded ears. This means, for instance,
that you cannot use the tool to verify the placement of the probe tube after inserting the hearing aid.

1. Instruct the client to be quiet during the measurements, and to continue facing the speaker
while sounds are playing.
The Be Quiet icon appears on the screen to remind you to be quiet and make sure that the
environment is quiet during measurements.
2. Click the ProbeTube Assistant button on the toolbar.
3. Insert the probe tube until the end of the probe tube is placed just after the first bend of
the ear canal.
This representation of an ear canal shows the ear canal until approximately 3-4 mm from
the actual ear drum.

Aurical FreeFit
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A. Probe tube
B. Concha (the bowl-shaped part of the auricle, the
external ear, nearest the ear canal)
C. First bend in the ear canal
D. Second bend in the ear canal
E. The ear canal
F. The ear drum

4. Press the power button on FreeFit or click Play in the ProbeTube Assistant dialog to start
the guided placement.
During guided placement, pink noise will be played.

Note • If the ProbeTube Assistant has difficulty detecting the location of the probe tube,
check the following:
- the ear canal must be free of cerumen and debris;
- the client must be facing the speaker;
- ambient noise must be as low as possible;
- you must not touch the probe tube or block the sound field with your hands or body.
5. Stand behind the client and insert the probe tube according to the on-screen instructions.
You can use the millimeter markings on the probe tube to assist you in moving the probe
tube the recommended distance.
6. After each on-screen instruction, the ProbeTube Assistant makes a new measurement,
calculates the new position and displays the next instruction.
During the measurement, do not touch the probe tube and do not block the sound field
with your body or hands.
In some cases, the Do not block sound field icon appears on the screen to remind you to
stand behind the client and keep your hands out of the sound field.

7. Reposition the probe tube as instructed, until it has been successfully placed.
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8. Press the power button on FreeFit or click Stop in the ProbeTube Assistant dialog to stop
the signal. When the measurement is done, the ProbeTube Assistant automatically switches
to the other ear.
9. If you wish to continue working on the same ear side, select this ear once more in the toolbar before clicking Play.
10. To start the guided placement on the opposite ear, press the power button on FreeFit or
click Play in the ProbeTube Assistant dialog.

Using recommended distances to assist in probe tube placement
If you wish to place the probe tube without using the ProbeTube Assistant, follow these guide lines:
1. Place the black marker ring at the recommended distance from the tip of the probe tube.
2. If the reference point of the black marker ring is the intertragus notch, you can add 8 mm for the concha depth.

Note • To avoid touching the ear drum, you must take into account that the probe tube should not be inserted closer
to the ear drum than 4 mm.

Aurical FreeFit
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Note • The length of ear canal may vary from country to country and even depending on the physical size of
the patient, so make sure that you take this into account when you use the recommended distances.

Note • In the case of children, otoscopy is especially recommended to prevent contact with the eardrum.

Recommended distances
The recommended distances are based on the complete average lengths of ear canals, where the reference point is
at the opening of the ear canal.
Men

25-29 mm

Women

22-26 mm

Children from 6 months

18-22 mm

Distances are based on:
•

EN 61669:2016

•

Wayne Staab, The Human Ear Canal -V, July 7, 2014.

•

Voss SE(1), Herrmann BS. How does the sound pressure generated by circumaural, supra-aural, and insert
earphones differ for adult and infant ears? Ear Hear. 2005 Dec; 26(6):636-50.

Caution • Carefully insert the probe tube into the ear canal until the black marker ring reaches the intertragal
notch.

After inserting the probe tubes
1. When you have placed the tubes correctly, instruct the client not to move the head so as not to disturb the position
of the probe tubes.
2. You can now insert hearing aids or earmolds.
3. Make sure that you hold the probe tube carefully in place while you insert the hearing aid or earmold.

Probe with standard accessories
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Removing the probe tube after completing measurements
When you have completed the measurements and
removed the probe tube from the client's ear, you can
remove the probe tube from the probe tube guide:
•

Do not pull the probe tube backwards through
the probe tube guide. Instead, lift the probe tube
sideways out of the probe tube guide.
This minimizes the amount of cerumen that is
transferred from the probe tube to the probe
tube guide.

Aurical FreeFit
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4

Making Probe Microphone Measurements and
coupler based fittings with FreeFit and PMM
When you perform probe microphone measurements with speech stimuli, you can verify that your client’s hearing instruments have been properly fitted to accurately fulfill the client's audibility needs when the client uses the instruments in
the real world.
Ideally, when fitting hearing instruments, you should verify audibility at several input levels. Soft speech should be audible,
conversational speech should be comfortable, and loud sounds should be tolerable.
The Otosuite PMM module calculates the client’s prescriptive targets based on the reference audiogram, and other data
that you enter. You can use the Aided Response screen in PMM to measure the LTASS with various sound signals and
levels, and to monitor the aided response while you adjust the client’s hearing instruments. You can display the target
curve as an overlay, for example, while you adjust and monitor the aided response.
The PMM module also provides tests for measuring unaided and occluded response, as well as tests for verifying and
demonstrating noise reduction functionality.
In PMM, you can make coupler based fittings using RECD values that you measure or enter in the RECD test screen in
PMM, RECD values predicted by the fitting rule, or average RECD values that you enter in the Options window. Coupler
based fitting allows you to make the fitting and verification without the patient being present. The applied RECD is used to
convert all threshold, target and measurement values from real ear to individualized coupler SPL values. The fitting can
thus be carried out in the coupler and should closely approximate a fitting achieved with real ear PMM.

4.1

Selecting and displaying a reference audiogram
Before you can use Otosuite PMM module to calculate the client’s prescriptive targets, you must load the client’s reference audiogram. The reference audiogram serves as the basis for the fitting prescription. You can display the client’s reference audiogram, also called the unaided threshold, in the graph when you perform a measurement.
By default, the last available audiogram for each ear will be loaded automatically. For more information, see Making new
measurements ► 70. If you are working with Noah, you can select an alternate audiogram that you have stored in Noah.

To select a reference audiogram stored in Noah
1. Open any tab in the PMM module.
2. Click Measurement > Reference Audiogram.
3. In the Reference Audiogram Selection window, select an audiogram for each ear, and then click OK.
If no audiogram is available in Noah or if you are operating Otosuite in stand-alone mode, you can enter an audiogram
manually in the Audiometry module. The newly created audiogram will be selected by default and will then become
available in the Reference Audiogram Selection window.
You can display the reference audiogram in the graphs on any of the tabs in Counseling and Simulations and PMM.

To display the reference audiogram
•

In the Overlays box, select the Reference Audiogram check box. If you select the Unusable Area overlay, the reference audiogram is also displayed.

Displaying Real Ear Measurement data from other applications
The PMM module can display data from other HIMSA certified REM applications. You cannot change data from other
applications, and there may be some types of data that are specific to the application from which the data originates.

Aurical FreeFit
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4.1.1

HL and SPL views
You can choose to have measurement graphs in the PMM module displayed in either HL or SPL. Audiograms are as a rule
measured in HL. When you select the SPL view, the audiogram values are converted from HL to SPL. Conversely, measurements that were recorded in SPL must be converted to HL by the system when HL view is selected. This includes PMM
measurements and prescriptive targets.
When converting between HL and SPL, the PMM module does not use static values. PMM takes into account the parameters set in Fitting Details. The conversion is transducer dependent, so that the reference audiogram that is displayed
more closely represents the values used internally by the applied fitting rule.

HL to SPL Conversion Formulas
In correspondence with the transducer selection, the RECD, REUG, and any parameter impacting their calculation influence the HL/SPL conversion. 3 basic formulas apply (ANSI 3.6:2004):

For HL to SPL (real ear)
For SPL to HL, the following formulas apply in reverse.
•

For inserts:
Threshold [dB SPL] = Threshold [dB HL] + Applied RECD (mold or tip) + insert phone RETSPL (HA1 or HA2)
Insert Real Ear SPL thresholds are based on an HA1 reference, meaning RECDs measured with HA2 coupler will be converted to the appropriate HA1 reference. When no measured RECD is available the age-appropriate average RECD associated with HA1 coupler (Tip or Mold) is applied.

•

For sound field:
Threshold [dB SPL] = Threshold [dB HL] + Applied REUG (0, 45, or 90 degree) + Sound field RETSPL (0, 45, or 90
degree)

•

For headphones:
Threshold [dB SPL] = Threshold [dB HL] + real ear-to-6cc transform + RETSPL

For SPL (real ear) to SPL (2 cc)
•

Threshold [dB SPL 2cc] = Threshold [dB SPL real ear] - Applied RECD
The RECD used for this transform is dependent on the hearing instrument style. In the case of ITE, ITC, CIC it is an HA1
+ tip RECD. In the case of BTE it is an HA2 + mold RECD. In the case of Body Worn it is an HA2 + tip. When no appropriately measured RECD exists, it will be predicted accordingly. It is this RECD which is shown as the Predicted RECD
overlay in the RECD test type.

4.2

Validated fitting prescriptions
You can choose between four validated fitting prescriptions to use in the PMM module, and you can configure each of the
rules.

DSL v 4.2
The Desired Sensation Level (DSL) prescriptive method is a systematic approach to hearing instrument fitting, which seeks
to ensure that amplified speech will be audible and comfortable, while loud sounds will not be uncomfortable. DSL 4.2
was originally developed with the goal of individualizing hearing instrument prescription and fitting to children.
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The DSL 4.2 algorithm provides constant level targets. In PMM, when the DSL 4.2 fitting prescription is selected, REAG targets for broadband stimuli are derived by using the signal spectrum. This allows PMM to create targets that are more relevant for the given input signal.
PMM derives REIG values from DSL 4.2 REAG targets and the Applied REUG.

DSL v 5.0
The DSL® v 5.0a algorithm is a further development of DSL 4.2. It allows for fine-tuned fitting for three population groups:
infants, children, and adults. It takes into consideration the type of audiometric measurement (including corrections for
ABR/ASSR measurements), type of fitting (binaural versus monaural), and type of hearing loss (including corrections for
mixed and conductive hearing loss). Enhanced normative data for RECD with ear tip or earmold coupling that are better
suited to hearing aid fitting in infancy are implemented. Additionally, the algorithm is improved for achieving more comfortable adult targets and targets for different listening environments. DSL 5.0b includes targets for speech-noise and puretone stimuli up to input levels of 85 dB.

NAL-NL1
NAL-NL1 is a prescription procedure for non-linear hearing aids that aims to maximize speech intelligibility by equalizing
loudness relationships across speech frequencies. The NAL-NL1 has the additional aim that hearing impaired people should
never perceive the overall loudness of a sound to be any greater than that which a normal hearing person would perceive.
Unlike other non-linear prescription procedures, NAL-NL1 does not attempt to normalize loudness separately at each frequency.
PMM derives REAR targets by adding the NAL NL1 REAG to the signal spectrum.

NAL-NL2
NAL-NL2 is a refinement of NAL-NL1. NAL-NL2 takes into account average preferences based on age, gender and hearing
instrument experience:
• The client’s birthdate is used to calculate the client’s age, and a higher overall gain is prescribed for children compared to adults.
•

New users are prescribed less gain than experienced users.

•

Females are prescribed less gain than males.

•

Binaural gain correction increases with input level, and is greater for symmetrical hearing loss compared to asymmetrical hearing loss.

PMM derives REAR targets by adding the NAL NL2 REAG to the signal spectrum.

4.2.1

Selecting and configuring a target rule
To select and configure a target rule:
1. Click the Fitting Details icon on the toolbar (or press F10).
2. Fill in the fields in the window.

Note • The selections made in the Fitting Details window are not stored on an individual client basis. However, the
prescriptive target calculated according to the fitting details is stored for each measurement.
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Display Fitting Details for each new client
To have the Fitting Details dialog be displayed each time you start a new session, select the .Show Fitting Details automatically option in Tools > Options > PMM > General under Measurement, Misc.

Note • if you change a setting and want it to apply next time you start Otosuite, you must save the current settings as
startup settings.

The following table describes the fields in the Fitting Details window
The settings available in the Advanced Settings sections are dependent on the selection in the Target Rule field. For
each setting that is not generally available, it is stated in the table which rule it applies to.
Field

Target Rule

In this field, select the fitting prescription that you want to use for the current client.
The fields that appear in the Fitting Details window depend on which target rule you select,
and the options for some of the fields also vary depending on which target rule you select.
You can select Manual if you want to enter target curves manually. For more information, see
Entering Target Curves Manually ► 42.

Note • If you change target rules after filling in the other fields in the Fitting Details window, the settings for each field will be mapped to the closest equivalent for the new target rule, but you may want to verify that the settings are still correct.

Fitting Mode

Indicate whether you will make a Real Ear or Coupler based fitting. You can also change this
setting by clicking the icon on the toolbar.
•

Coupler: Otosuite makes all conversions necessary to make the fitting in the coupler
rather than with real ear PMM. RECD becomes not only an input for HL/SPL conversion
but also a direct input parameter for the target rule calculation. See also the Applied
RECD field.

•

Real Ear: RECD influences only HL/SPL conversion and is not a direct input parameter for
target rule calculation.
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Field

Applied REUG

The client’s REUG is either measured, entered or predicted. By default, if there are no measurements, and no user test has been selected, the Applied REUG will be predicted by the
chosen fitting rule. However, if you change the fitting rule after making a measurement, the
Applied REUG does not automatically change. The Applied REUG setting for the existing measurement is kept so the HL to SPL conversion stays consistent throughout the session.
However, you can choose to change the selection and then the conversion will be recalculated accordingly. For more information about HL to SPL conversion, see HL and SPL views
► 28.
You can select one of the following options:
•

Measured REUG: the unaided response that is measured for the client will be used.

•

Custom REUG: the Custom values in the Options window will be used. You can enter
average values for your local population or target group in the Options window: In the
Options window, click PMM > Unaided Response > Curve Settings > Custom REUG.

•

KEMAR: the international KEMAR values will be used.

•

Predicted REUG (DSL 4.2/DSL 5.0/NAL NL-1/NAL NL2): The client's REUG will be predicted by the fitting rule specified in this field.

Date of birth

•

Under NOAH:
If the birth data has been entered in advance in NOAH's Client module, this box will automatically be filled in. This date can be edited by using the drop-down button to select an
alternate date from a calendar.

•

Stand alone:
If you are operating OTOsuite outside NOAH and have not already entered the date of
birth into the client details, enter the correct birth date. You can use the drop-down button to select the date from a calendar.

Gender
Applies to NAL-NL2

NAL NL2 takes the client’s gender into account when creating prescriptive targets.

Connected to NOAH
If the gender is registered in NOAH, it is automatically copied to the Gender field both in Client Details and in Fitting Details, and you cannot edit it. If the gender is not registered in
NOAH, then the Gender field in Fitting Details contains Unknown, and you can select either
Male or Female.

In stand-alone mode
If the gender is registered in the Client Details dialog, it is copied to the Fitting Details dialog, and you cannot edit it. If the gender is not indicated in Client Details, then the Gender
field in Fitting Details contains Unknown, and you can select either Male or Female.
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Field

Applied RECD

The contents of this field determine the RECD values that will be applied to the target curve
and used to manage HL to SPL conversion and real ear to coupler SPL conversion when you
make a coupler based fitting. The client’s RECD is either measured, entered or predicted. By
default, if there are no measurements, and no user test has been selected, the Applied RECD
will be predicted by the chosen fitting rule. However, if you change the fitting rule after making a measurement, the Applied RECD does not automatically change. The Applied RECD setting for the existing measurement is kept so the HL to SPL conversion stays consistent
throughout the session. However, you can choose to change the selection and then the conversion will be recalculated accordingly. For more information about HL to SPL conversion,
see HL and SPL views ► 28.
You can select one of the following options:
•

Custom RECD: the Custom values in the Options window will be used. You can enter
average values for your local population or target group in the Options window: In the
Options window, click PMM > Unaided Response > Curve Settings > Custom RECD.

•

Measured RECD: Use RECD values that you have measured or entered manually in the
RECD screen, or values stored in NOAH.

•

Predicted RECD (DSL 4.2/DSL 5.0/NAL NL-1/NAL NL2): The client's RECD will be predicted by the fitting rule specified in this field.

HI Type

To ensure RECD values are applied correctly, make sure that the correct HI Type and type of
tubing or CIC insertion depth is selected. This information affects the target curves and the
predicted RECD.
The available selections will vary according to your selection of fitting rule.

Venting

The contents of this field indicate the size of vent chosen for the fitting. Venting corrections
are only applied in the 2-cc transform and will not affect the targets in real ear formats (REAR,
REAG, REIG).

Note • Most hearing instrument manufacturers apply their own venting correction
factors rather than the predicted corrections from the validated fitting prescriptions. As
such, it is difficult to accurately predict the effects of these corrections. Occluded is the
recommended venting size selection and is set as the default.

Note • Selecting Open as the venting here has no impact on the calibration strategy
used. To switch from standard calibration, check Use Open REM Calibration.
Amplification

When using DSL to fit adults, if you select Binaural, there will be a 3 dB reduction in the target gain when compared to a monaural fitting. In DSL, the Binaural option is disabled when
the client age is less than 18.
When using NAL for symmetrical hearing losses, the correction for binaural summation is
between 3 and 8 dB, with increasing correction for increasing input levels.
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Field

Transducer

The selected transducer is used in conversion of HL to SPL values to compensate for the fact
that the transducers are calibrated with couplers simulating average adult ear, whereas the fitting prescriptions take into account individual variability in ear canal size and shape.
DSL includes options regarding Sound Field: SF 0 stands for Sound Field at 0° azimuth; SF 45
stands for Sound Field at 45° azimuth; SF 90 stands for Sound Field at 90° azimuth. With DSL,
the REUG Orientation field is filled in automatically if you select one of these options, and
changing the REUG Orientation automatically changes the contents of this field.
Available ABR transducers for DSL are ABR Tip eHL and ABR Mold eHL. nHL to eHL conversion is handled in the Tone Audiometry manual entry mode. The DSL algorithm does not
support TDH headphones as an ABR transducer type, and TDH headphones are therefore not
an option.

Use Bone Conduction

When Yes is selected:
DSL adjusts the targets for conductive hearing loss by increasing predicted UCL values by 25%
of the air-bone gap. This will result in a small increase of the target amplification. For a maximal air-bone gap, the correction adds 5 to 9 dB of gain and output to the aided speech targets, depending upon the hearing level. Targets are limited to a maximum of 140 dB SPL in
the ear canal.
NAL-NL1 and NAL-NL2 applies the sensorineural loss formula to the sensorineural part of the
loss (that is, that part reflected in the bone conduction thresholds) and then adds gain equal
to 75% of the conductive part of the loss (that is, that part reflected in the air-bone gap).
No corrections for air-bone gap are applied for ABR data. The check box Use Bone Conduction in Setup is grayed out when the transducer type is ABR Tip eHL or ABR Mold eHL.

Experience
Applies to NAL-NL2

In this field, you indicate whether the client is an experienced hearing aid user, or a new
hearing aid user.
New users are prescribed less gain than experienced users.

Use OpenREM calibration/Use Stored
EQ (Equalization)

Select this field if you want to perform Open REM calibration for this client. In Coupler Based
Fitting mode, Stored EQ is used.
See also Making OpenREM/Stored EQ measurements ► 47.

Click the Advanced Settings button to adjust more advanced setting parameters.
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Advanced Settings
Advanced Settings

Program type

Allows selection of Quiet versus Noise program type.

Applies to DSL 5.0

This selection is used to derive targets for two listening environments. Clinicians may choose
to change this setting if they are making measurements for quiet versus noise programs/memories on the same instrument.

Limiting
Applies to NAL-NL1
and NAL-NL2

Use this field to specify whether the hearing aid output limiting is controlled independently
for each channel of a multi-channel hearing instrument or by the total power of the signal.
Wideband is the default, and generally recommended setting.

No. of Channels

State the number of channels in the hearing instrument.

Compression type/
Prescription type

DSL 5.0 (Compression type)

Applies to DSL 5.0 and
DSL 4.2 respectively

You can select either Linear or Non-linear (default).

DSL 4.2 (Prescription type)
Select Linear to fit hearing instruments with peak clipping or output limiting compression.
Select WDRC (fixed) for WDRC hearing instruments with a linear compression ratio. Select
WDRC (variable) to fit WDRC hearing instruments with a curvilinear compression ratio.

Compression/Compr.
Threshold

This field indicates the wideband compression threshold (knee point) at which the hearing
instrument goes into compression. It impacts the target curves.
The default for NAL is 52; the default for DSL 4.2 is IMin. When fitting wide dynamic range
compression (WDRC) hearing instruments, select the compression threshold. IMin is an abbreviation for Input Minimum.

Compression Speed
Applies to NAL-NL2

Here you can indicate the compression speed of the client’s hearing instrument. The options
are: Slow, Fast, Dual / Intermediate / Adaptive.
Slow = release time longer than 300 ms.
Fast = release time shorter than 50 ms.

Client Type
Applies to DSL v 5.0

The contents of this field define whether the Pediatric or Adult targets are generated. DSL v5
introduces lower level of prescribed gain for adults (based on the assumption that adults have
acquired hearing loss) and higher level prescribed gain for pediatric targets (based on the
assumption that pediatric clients have congenital hearing loss).
The adult-child difference decreases with increasing hearing loss.
Selecting Pediatric for an adult client will yield higher levels of prescribed gain.
The Client Type field is filled in automatically based on the client’s birthday, and can be
changed, for example, for adults who have congenital hearing loss.

Fitting Depth
Applies to NAL-NL2
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Here you can indicate the insertion depth of the medial end of the client’s earmold. The
options are: Standard, Deep, and Shallow.
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Advanced Settings

Target Type

The selection in this field determines whether targets are based on REAG or REIG.

Applies to NAL-NL1
and NAL-NL2

If REAG is selected, the prescribed gain does not take into account the individual unaided ear
canal, but is based on a standard adult ear canal.
If REIG is selected, the prescribed gain is based on either the measured REUG or a standard
REUG for the client's age group.
REIG is the default setting, as most hearing instrument fitting systems use this setting for NALNL2.

RECD Type

RECD Type refers to the type of coupler adapter and type of earpiece to be used for the
coupler-based fitting. It is relevant when you have selected Predicted or Custom RECD in the
Applied RECD field.
Select the correct combination of coupler adapter (HA1 or HA2) and type of earpiece (Tip or
Mold). The selection made here is mirrored to the corresponding selection in the Control
Panel in RECD test mode.

Note • For assessment purposes the RECD is applied only when the transducers used to
measure hearing are insert earphones.

This is because RECD relates to a 2cc coupler and TDH headphones are related to a 6cc
coupler. If any other transducer is used to measure hearing, there will be no impact/changes
to the hearing threshold as the RECD changes.
•

That is, for any transducer besides insert phones the only impact of the RECD measurement will be in the correct selection of the RECD Type and hearing instrument type.

If those settings accurately reflect your fitting, they will be accurately reflected in the target
and the application of RECD.

Note • You cannot mix measurements with different RECD types in the same session - you
must use the same RECD type for both ears.

REUG Orientation

Defines the REUG measurement condition. The default setting is 0° azimuth.
For DSL, the field is filled in automatically based on the transducer that was used to create
the reference audiogram. In some cases, you may want to change the selection. For example,
if the audiogram was made in sound field, the data does not contain information about the
speaker angle, so you may need to change the setting from SF 0 to SF 45 or SF 90.
For NAL, this field is not linked to the Transducer field, and the only options are 0° and 45°.

Applied REDD

Average(LTASS) is the only available REDD selection.

Language Type

In this field, you indicate whether the client’s language is Non-tonal (such as English) or Tonal
(such as Mandarin). In tonal languages, fundamental frequency is used to convey meaning, and
the acoustic cues to fundamental frequency lie in the low frequencies, so NAL-NL2 prescribes
a higher gain for frequencies below 800 Hz in tonal languages.

Applies to NAL-NL2
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Advanced Settings

Verification Signal
(Automatic selection)

4.2.2

The verification signal is automatically selected in the background based on the signal used to
make the measurement. There is no selection of verification signal in the fitting details dialog.
•

Targets for Speech Noise and Pure Tone signals are available between 50 and 85 dB SPL.

•

Targets for Speech are available between 45 and 80 dB SPL.

Fitting prescription references
For further information about the fitting prescriptions, see the following Web sites:

DSL:
DSL Clinical Protocols. Available from http://www.dslio.com.

NAL:
National Acoustic Laboratories. Web site: http://www.nal.gov.au/
See also the literature references in Fitting prescriptions ► 131.

4.3

Configuring PMM measurement buttons and test screens
You can configure the measurement conditions that are used to make measurements in PMM, and you can determine
what is shown in the work area.

4.3.1

Configuring measurement buttons in PMM
The control panels in Unaided Response and Occluded Response each contain one measurement button, the control
panel in FreeStyle contains six measurement buttons and the control panel in Aided Response contains five measurement
buttons. This section describes how to configure the measurement buttons in Aided Response, and the buttons in
Unaided Response and Occluded Response can be configured in the same way.
The control panel in Aided Response contains five buttons that can be configured to make five different measurements.
For each button, you can select a signal type, and you can specify the level and duration at which it will be played. For
example, you can configure one button each for soft, average and loud levels, and one for MPO measurements. You can
also assign a descriptive title to each of the buttons.
The measurement buttons in FreeStyle can be configured in the same way as the other measurement buttons in PMM,
but they also contain additional functionality. For more information, see Configuring the Snapshot Play button and the
measurement buttons in FreeStyle ► 60.
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A.
B.
C.
D.

Measurement button
Finalize Measurement button
Configuration drop-down button
Status fields

Configuring a measurement button in the Aided Response, Unaided Response or Occluded Response
control panel
You can see the configuration settings for a button by hovering the mouse over the button. The settings are displayed in
the status fields in the control panel.
1. Click the drop-down button to the right of the measurement button that you want to configure.
2. Point to Signal Type and then select the sound file that you want the button to activate.
3. Point to Level, and then select the sound level that you want the signal to be played at when the button is activated.
4. Point to Duration and then select the number of seconds for which you would like the signal to be played.
–

Full Length plays the signal for the full duration of the sound file.

–

Custom opens a window where you can enter the duration in seconds.

Note • Accurate LTASS and percentile measurements require an absolute minimum duration of 10 seconds. 14
seconds is the default setting in PMM to accommodate the signal length of our standard passages.

5. To close the menu, press Esc.

Renaming a button
1. Click the drop-down button to the right of the measurement button that you want to rename.
2. Click Change Title and then fill in the Title field.
3. Click OK.

Maximum Power Output (MPO)
In Aided Response and FreeStyle, you can set one of the measurement buttons to make an MPO measurement. This will
allow you to verify that the hearing instrument does not exceed the client’s uncomfortable level (UCL) and to match the
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measurement to the MPO target. If you select MPO as the signal type for a button, the MPO target is generated by the fitting rule, based on Real Ear Saturation Response for NAL-NL1, or REAR 85 for DSL 5.0.
The signal and duration are set automatically. For each button, you can set an MPO level for real ear measurements, and
an MPO level for coupler measurements.
As a safety precaution, it is not possible to select the Loop function with the MPO signal.

Vocal Effort
In Aided Response, if you select a speech signal or speech-like signal and if a fitting rule that calculates vocal effort has
been selected (not NAL), then vocal effort is applied to the signal. For speech and speech-like signals, when you select a
level from the drop-down menu for a measurement button, the vocal effort (soft, average or loud) that corresponds to the
level is indicated after the dB level. When the level has been assigned to a measurement button, the vocal effort is also
included in the status fields in the control panel, and in the curve legend.
If vocal effort is loud (75 dB), the signal is equalized so that the signal spectrum matches the vocal effort that corresponds
to the level.
Soft and average signals are only differentiated by level, as the signal spectrum is similar for these levels.
Vocal effort does not apply to non-speech signals, such as pink or white noise, and vocal effort is not indicated with the
level for these signals.

Copying the settings from one measurement button to another
1. Click the drop-down arrow on the measurement button with the settings that you want to reuse.
2. Click Copy settings to and then select the button to which you want to copy the settings.

4.3.2

Specifying what to show in the graphs
Use the icons in the toolbar to determine what is displayed in the graphs, for example, which view mode, and one or both
ears. See PMM menus and toolbar icons ► 71.
You can select different overlays in the Overlays box, to further demonstrate or emphasize the different aspects of the client’s hearing loss.
The overlays that are available depend on the current test screen and view mode. For example, some overlays are not
available in Unaided Response, and many of the overlays are not available in Gain views.

The Overlays box
In the Overlays box, you can select or deselect the check boxes to view or hide various features.
You can determine which overlays are displayed as default for a specific test screen: Tools > Options > Overlay Selection.
If you wish to return to the default values, click Default in the Overlays box.
Overlay Name

Description

Pictures

Shows common types of sound and where they are located in the various areas of the audiogram.

Severity

Shows a scaled representation of the various levels of severity for categorizing a hearing loss.
See also Configuring the Severity overlay ► 41.
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Overlay Name

Description

Unusable Area

Shades the area below thresholds and above uncomfortable levels (UCL) in order to visualize
the client’s residual dynamic range.
If the UCL has been measured for the client at a minimum of two points, then the measured
UCL is displayed, and the rest of the curve is interpolated.
If the UCL has not been measured at a minimum of two points, the UCL is estimated by the
DSL fitting prescription, based on the unaided threshold. The internal DSL v5.0a algorithm
will be used to predict UCL data, regardless of which fitting rule is selected.

Speech Banana

Shows the area where normally spoken speech sounds appear in the audiogram. Used to visualize the speech range in the audiogram.

Customized

Recalculates the speech banana according to the dynamic range of the current audiogram.
The customized speech banana is the Long Term Average Speech Spectrum (LTASS) that has
been scaled in relation to the client's residual dynamic range. This means that the customized
speech banana illustrates normalized loudness.
You can use this overlay to explain the concept of reduced dynamic range and the purpose of
compression in hearing instruments.

Speech Letters

Shows the various letters in normal speech as they are placed in relation to the Speech
Banana. Used to visualize affected speech sounds.

Tinnitus

Shows the tinnitus points from the latest tinnitus session.

Target Curves

Shows the target curves calculated by the fitting rule that you have selected, based on the client’s reference audiogram and the signal that has been configured for each measurement button.
If the Target Curves option is not selected, then target curves will never be displayed.
If the Target Curves option is selected, but the specific curves are not selected, then target
curves will be displayed as follows:
•

When you mouse-over a measurement button, the target curve for that button is displayed.

•

When you mouse over the sequence button, target curves for all measurement buttons
that are selected for the sequence are displayed.

•

When you play a measurement button, the target curve for the current measurement is
displayed. If Binaural Stimulus Asymmetry correction is being used, the compensated target is displayed during and after the measurement

If the Target Curves option is selected and you select Preview 1, for example, the target
curve for the first measurement button is displayed at all times except when another measurement button is being played, or when you mouse-over another button.
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Overlay Name

Description

Percentile

Shows the percentile curves for the current test. 1% of the signal measured at the eardrum
exceeds the higher-level curve. 70% of the signal exceeds the level of the lower-level curve.
See Percentile curves ► 41.
These curves are commonly referred to as the speech peaks and valleys which are generally
12 dB above and 18 dB below the LTASS, respectively. The Speech Banana is a standard representation of the speech peaks and valleys and the area in between.

Peak Curve

Shows a live measurement of the highest level of each frequency for the current sound signal.

Reference Audiogram

Shows the client’s unaided hearing threshold, based on the reference audiogram. See Selecting and displaying a reference audiogram ► 27.
If the UCL has been measured for the client at a minimum of two points, then the measured
UCL is displayed, and the rest of the curve is interpolated.
If the UCL has not been measured at a minimum of two points, the UCL is estimated by the
DSL fitting prescription, based on the unaided threshold. The internal DSL v5.0a algorithm
will be used to predict UCL data, regardless of which fitting rule is selected.

Measured
REUR/REUG

Shows the unaided response that has been measured.

Used UG

Shows the unaided gain that has been used to calculate the REIG.
The REUG that is used depends on what has been selected in the Applied REUG field in the
Fitting Details window. See Applied REUG ► 31.

KEMAR

Shows the international KEMAR values for REUG.
You can use this overlay in Unaided Response to compare the client’s actual measured REUG
to the average REUG.

Measured
REOR/REOG

Shows the occluded response that has been measured for the client.

Compression Ratio

Shows how much the hearing aid has compressed the sound.

Show Signal Spectrum
You can display the signal spectrum for a measurement:
•

In the control panel, select the Show Signal Spectrum check box.

When you then mouse over a measurement button, the signal spectrum for the sound file assigned to the button is shown
in the graph view. 1% of the signal exceeds the higher-level curve, and 70% of the signal exceeds the lower-level curve.
The signal spectrum is also displayed on the graph during the measurement, as a static curve. This can be seen as the
"speech envelope" or "Speech Banana" for the current signal type and level.

Note • This function is disabled in Gain view.
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Long Term Average Speech Spectrum (LTASS) curves
The primary curve displayed for every measurement is the Long Term Average Speech Spectrum (LTASS). When the measurement is finished, this curve shows the average level of each frequency over the duration of the measurement.
The spectrum of a speech sample varies over time. For the LTASS measurement to result in a stable, repeatable result, it
must be based on a sound sample with a minimum duration of 10 seconds. The default LTASS measurement duration in
PMM is 14 seconds, to accommodate the signal length of our standard passages. The LTASS is calculated on samples of
128ms, and it is displayed and stored in 1/3 octave bands in Unaided Response, Occluded Response, Aided Response and
Noise Reduction. In FreeStyle, the default setting for the curve resolution is 1/24 octave, but you can select 1/3 octave resolution . In the Options window, click PMM > FreeStyle > Measurement, Curve Settings > Curve Resolution.

Percentile curves
The percentile curves display a dynamic view of the signal spectrum, measured at the eardrum. This dynamic view includes
the LTASS, 1% and 70% curves. The levels which are exceeded by 1% of the signal measured at the eardrum are indicated
by a curve which is commonly referred to as the peaks of speech. The levels which are exceeded by 70% of the signal are
indicated by a curve commonly referred to as the valleys of speech. The percentile curve is displayed dynamically, whereas
the signal spectrum is a static average for the input signal and its full duration. Also, the percentile and LTASS curves are
measured at the eardrum, and thereby reflect fully the dynamics of the aided response.
To display the percentile curves during and after measurement:
•

Select Percentile in the Overlays box.

STASS Curve
If you select the Loop check box and then click a measurement button, the signal that has been configured for the measurement button is played continuously, and the STASS (short term average
speech spectrum) curve is displayed. You cannot record a curve while in STASS mode.
If you click Stop, the signal stops without storing a curve.
If you click the Finalize Measurement button, the curve switches to LTASS mode. Then the measurement curve is stored when the LTASS duration elapses, or when you click Stop. Note that an
accurate LTASS measurement requires a sound sample with a minimum duration of 10 seconds.

Configuring the Severity overlay
You can configure the Severity overlay. Click Tools > Severity Overlay to open the Severity Overlay window, which contains the definitions of the severity bands that are displayed when you select the Severity overlay.
You can edit the headline that is displayed for a severity band, and you can change the lower boundary for a severity band.
The upper boundary for the adjacent band is automatically changed.
The default number of severity bands is six, but you can display fewer bands by merging two or more bands.

Merging bands
1. Assign the same value to the lower boundary for two or more bands.
2. Delete the headline for all but one of the merged bands.
See the following example:
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4.3.3

OnTarget view
In Aided Response, you can click the OnTarget icon to display one additional graph in monaural view, or
two additional graphs in binaural view. The OnTarget (Gain) graph shows a live display of the difference
between the measured curve and the target curve in order to make adjustments to the hearing instrument
programming much easier.
The OnTarget (Gain) curve is calculated as the target gain minus the measured gain. This means, for example, when the
curve is negative the gain of the hearing instrument should be increased. The OnTarget curve is always shown in Gain
view.
In binaural view, the measurement graph and the OnTarget graph are different sizes. You can alternate which graph is larger by double-clicking in the smaller graph.

4.3.4

Feature-2-Benefit view
In FreeStyle, you can click the Feature-2-Benefit icon to display one additional graph in monaural view, or
two additional graphs in binaural view. The additional graph displays a difference curve for each set of
paired measurements (curves 1 and 2, 3 and 4, and 5 and 6).
The difference curve in Feature-2-Benefit view is calculated as the gain of the first curve (curve 1, 3 or 5) minus the gain
of the second curve (curve 2, 4 or 6).
In binaural view, the graphs are different sizes. You can alternate which graph is larger by clicking in the smaller graph.

The curve legend in Feature-2-Benefit view
In Feature-2-Benefit view, the curve legend displays the RMS difference between the paired curves. This is the difference
in RMS at the probe microphone.

4.4

Entering Target Curves Manually
Instead of selecting one of the fitting rules to automatically calculate target curves, you can choose to enter target curves
manually. You can enter a target curve for each of the measurement buttons in the Aided Response module. When you
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enter the target curves, you indicate whether they are for REIG or REAR measurements. Then they will only be displayed
in the corresponding view.

To enter a target curve manually:
1. Press F10 to open the Fitting Details dialog.
2. In the Target Rule field, select Manual.
Most of the fitting parameter fields disappear, and a Targets button appears.
3. Click the Targets button.
The Manual Target Curves dialog appears, with a table for each ear. Each line in the tables corresponds to one measurement button in the Aided Response screen.
4. Enter the target values, between -30 dB and 140 dB.
For the numbered target-curve indicator to be displayed when you make a measurement, you must enter a value in
the shaded field on each line.
5. In the Target curve type field, indicate whether the targets are for REIG or REAR measurements.
This selection applies to both ears and all lines. You can change the selection until you make a measurement. Once
you have made a measurement, you can change the target values, but not the type.
6. Click OK to save the target curves.
7. Fill in the remaining fields in the Fitting Details window, and then click OK.
A manual target curve will be displayed when you make a measurement of the relevant type (REIG or REAR), and the target curve will be saved with the measurement curve.

Note • If you change the settings for a measurement button, you must update the corresponding manual target
curve.

4.5

Using custom target rules
The PMM module allows you to create custom target rules. You can create an Excel file based on the
TargetRule.OTOtargetCalc.xlt Excel template.

Note • Microsoft Excel 2003 or newer is required to develop or use custom target rules.

In this file, you can enter formulas to calculate a target curve based on audiometry data and fitting details. Feeding this
information into the spreadsheet and retrieving the results for display will be handled automatically by Otosuite.
The Excel file contains several worksheets that are already set up so that Otosuite can populate them. On another worksheet in the file, you can then create formulas that calculate targets based on the data from Otosuite. Otosuite reads the
result from the file and displays the target curve in PMM.
Instructions for setting up a custom target rule can be found on the Otosuite installation DVD, in the following folder:
X:\\Support\TargetRules, where X: denotes the location of your installation media.
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Custom target rule files on the Otosuite installation media

4.6

Filename

Description

Custom target rule sample.OTOtargetCalc.xls

Sample custom target rule

TargetRule.OTOtargetCalc.xlt

Custom target rule template

Custom Target Rules.pdf

Documentation - How to set up a custom target rule

Selecting a FreeFit device
Before you use the PMM module for the first time, you must run the configuration wizard to set up your sound devices
and other preferences. You can also use the configuration wizard to connect to your FreeFit device for the first time.
Once you have configured PMM, you can use the Select Device icon on the toolbar to select a FreeFit device. This is particularly useful if you have more than one device, and you switch devices often.

Selecting a device
1. Click the Select Device icon.
The Select Your FreeFit page from the configuration wizard opens.
2. Select the device you wish to use, and then click OK.
For more information about the Select Your FreeFit dialog, see Configuring PMM ► 105

4.7

Performing an Aided Response measurement
Before you can make a measurement in Aided Response, you must do the following:
•

Perform probe tube calibration. See Calibrating the probe tubes ► 18.

•

Configure the Fitting Details dialog to select the fitting rule and target parameters. See Selecting and configuring a target rule ► 29.

•

Configure one or more measurement buttons in the control panel in Aided Response. See Configuring PMM measurement buttons and test screens ► 36.

•

Prepare the client and place the probe tubes in the client’s ears together with the hearing instrument. See Preparing
the patient ► 19.

When you click a measurement button in the control panel, the signal assigned to the button is played and the measurement curve is displayed in the graph. A measurement curve is stored after the duration of the button has elapsed,
unless the Loop function is selected.

Note • A measurement curve is also stored if you click Stop before the duration of the button has elapsed. However,
an accurate LTASS measurement requires an absolute minimum of 10 seconds.
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Restarting with the Finalize Measurement button
If there is an unexpected sound while you are making a measurement, for example if the client
sneezes, you can click the Finalize Measurement button to stop and restart the current sound signal and measurement. The current sound file will be played for either 14 seconds, or the duration
of the sound file if it is shorter than 14 seconds.
The Finalize Measurement button has a different function when used together with the Loop function. For more information, see Displaying a real-time Aided Response measurement ► 46.

4.7.1

Making a coupler based measurement using Aurical® HIT
You can make a coupler based fitting using the Aided screen in the same way that you would make a real ear fitting. Real
ear SPL values are converted to coupler SPL values and Otosuite uses Aurical® HIT to conduct measurements rather than
the FreeFit device.
The following procedure describes how to make a coupler based measurement. Before you can perform this procedure,
you must already have RECD values, either measured, predicted, or entered manually. For information about measuring or
entering RECD values, see RECD ► 51.

Making a coupler based measurement
1. Make sure that the Applied RECD field in the Fitting Details window is filled in correctly.
2. Select the Coupler based fitting icon on the toolbar.
3. Attach the hearing instrument to the coupler in Aurical® HIT.
For more information, see the Aurical® HIT and the Otosuite HIT module User Guide.
4. Continue to make the measurements as you would make any measurements in the Aided screen.
When Otosuite is in coupler based fitting mode, all conversions from real ear SPL to coupler SPL will be handled by Otosuite as part of the HL/SPL conversion for coupler mode. For more information, see HL and SPL views ► 28.

Note • Unaided and Occluded response measurements are always made in Real Ear mode.

Note • The Feedback Finder and Occluded Probe Tube Detector functions are not available in Coupler Based Fitting mode.

4.7.2

Recording a sequence of measurements
You can configure the system to perform a sequence of measurements in a row:
•

For each of the measurement buttons that you want to include in the sequence, select the check box to the right of
the button.

•

To make a sequence of measurements, click the Sequence button, or press F5.
The signals are played in sequence, and a measurement is stored for each signal.

You can see the results of the measurements in the graph. For information about the curve legend, see Viewing recorded
measurements ► 48
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4.7.3

Displaying a real-time Aided Response measurement
You can use the Loop functionality to display a graph of the short term speech spectrum for an Aided Response signal. The
average and percentile curves are calculated on a small number of samples, and are updated continuously. This provides
you with immediate feedback on the aided response, for instance, while you make adjustments to the client’s hearing
instrument.

Playing a loop of a configured sound signal
•

Select the Loop check box.

•

To start the loop, click the measurement button for the signal that you want to loop.
The signal that has been configured for the measurement button is played in a continuous loop
until you stop it.
While the loop plays, the graph displays the short term speech spectrum. You can use this functionality to immediately see the effects of adjustments to the hearing aid.

Configuring the liveliness of the curve
You can configure the liveliness of the short term speech spectrum curve with the Loop Mode Averaging option: Tools >
Options > PMM > General > Curve Settings > Loop Mode Averaging. This option determines the number of samples that
are averaged when updating the live measurement curve. If a faster option is chosen, the curve changes more quickly; if a
slower option is chosen, the curve becomes more stable and easier to read.

On Top mode
You can click the Switch to On Top Mode icon to display this measurement in On Top mode while
you adjust the hearing instrument with the hearing instrument manufacturer’s fitting software. See
also On Top mode in PMM ► 80.

In Loop mode
•

If you click the Stop button (the measurement button turns into a Stop button during measurement), the signal stops,
and no measurement is stored.

•

If you click the Finalize Measurement button, the graph displays the LTASS curve and the signal continues for 14
seconds while an LTASS measurement is recorded.

Creating and storing an LTASS measurement while in Loop mode
You can click the Finalize Measurement button while using the Loop functionality to create and
store an LTASS measurement for a 14 second duration. For example, you can make an LTASS measurement after adjusting the hearing instrument to verify that the aided response meets the validated fitting prescription.

4.7.4

Calibration of the sound level
When making measurements, it is necessary to control the signal level and spectrum. For open fittings the PMM module
uses the Modified Pressure method with Stored Equalization (MPSE), which is a hybrid of the two classic calibration methods (see Lantz, et. al. 2007). With this method, the sound field is equalized and the level is adjusted with the client
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present, and the reference microphone at the client's ear. This method takes the client's effect on the environment into
account, and uses a stored signal calibration for consecutive measurements. If you are fitting a hearing instrument with
more open coupling, you must turn off the hearing instrument before calibrating, because otherwise, sound leaking from
the ear can interfere with the calibration and influence the measurement. Choosing OpenREM calibration applies MPSE.
In Coupler Based Fitting mode, Stored Equalization is used.
The standard calibration protocol in PMM is a variant of the MPSE in the sense that the equalization is only stored for one
measurement. A brief automatic calibration signal is played and the level is set immediately before each measurement.
The standard calibration can be used whenever the fitting is closed/occluded, as indicated by a loss of ear canal resonance
when unaided and occluded measurement curves are compared.
When OpenREM calibration/Stored EQ is enabled, the automatic calibration is disabled. You must manually initiate a calibration before the first measurement in a session, and any time the client or objects in the sound field move.

4.7.4.1

Making OpenREM/Stored EQ measurements
Note • In order to perform accurate measurements, it is important to ensure that the system is calibrated correctly.
Any change in the position of people or objects in the sound field requires a new calibration.

Switching between standard and OpenREM calibration/Stored EQ
Do one of the following:
•

Click the OpenREM calibration icon or the Standard calibration icon on the toolbar.

or
•

Select or deselect the Use OpenREM calibration or Use Stored EQ (Equalization) field in the
Fitting Details window.

When OpenREM calibration/Stored EQ is enabled, the auto-calibration is disabled. You must manually initiate a calibration before the first measurement in a session, and any time the client or objects in the sound field move.

Perform OpenREM calibration or Stored Equalization
1. Make sure that the hearing instrument is turned off or muted, and positioned in the client’s ear or in the Aurical® HIT
chamber.
2. Click the OpenREM Calibration/Stored EQ button in the control panel.
3. Turn the hearing instrument on.
4. You can now click a measurement button.

Forced calibration
If you try to perform a measurement without having calibrated at least once during the session, the OpenREM Calibration
dialog box opens. After the calibration is completed successfully, you must click the measurement button again to initiate
the measurement.

Note • If you have measured REUR (Real Ear Unaided Response) or REOR (Real Ear Occluded Response) during the session, an automatic calibration has been performed while the hearing instrument was turned off, and you will not be
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required to perform an OpenREM calibration. However, it is advisable that you manually initiate a calibration since
the sound field was probably altered when you inserted the hearing instrument in the client’s ear.

4.8

Viewing recorded measurements

4.8.1

The VU meter

During measurements, the VU meter displays the input level at the reference microphone, measured in dB.
The VU meter turns red when the signal is stronger than the VU meter reference level, which you can set in the Options
window: select PMM > General > View, Misc. > VU Meter Reference Level.
The level measured at the reference microphone is not stored with the test curve.

4.8.2

The curve legend
The Legend box in the work area displays the latest results for each of the measurement buttons in the current test
screen. The buttons in the Control Panel, the measurement curves in the graph, and the lines in the Legend box are all
color coded, so that it is easy to see that the first line in the Legend box corresponds to the first button in the control
panel, and to the measurement curve in the graph that matches the color of the button.
You can edit the colors that are used for the curves in the Options window.
A. Curve displayed in graph
B. No measurement recorded
for the button
C. Target rule
D. Level of signal played
E. RMS level of signal measured
at probe microphone
F. Signal type
G. Fitting Details button
H. Comment button

The following information is displayed for each measurement in the Legend box:
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•

The Speech Intelligibility Index (SII) is calculated for measurements that use a speech or speech-like signal type. For
more information, see The Speech Intelligibility Index (SII) ► 49.

•

The level of the signal that was played, as well as the measured RMS level of the signal at the probe microphone. In
FreeStyle, for Live, CD or Recorded signals, only the measured RMS is displayed.

•

The signal type used for the measurement.

•

In FreeStyle, if the measurement is a Snapshot measurement, the Snapshot icon appears after the check box.
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Note • For a description of the contents of the Legend box in the Feature-2-Benefit view in FreeStyle, see The curve
legend in Feature-2-Benefit view ► 42.

Showing/hiding curves
You can hide or show a curve in the graph by adding or removing the check mark on the corresponding line in the Legend
box. This selection will also be reflected if you print a report.

Editing or viewing comments
You can add or edit a comment about a curve by clicking the Comments button on the corresponding line in the Legend box. You can hover the cursor over the Comments button to read a
stored comment.

Highlighting curves
To highlight a curve, click on the corresponding line in the Legend box.

4.8.3

The Speech Intelligibility Index (SII)
The curve legend in PMM displays the Speech Intelligibility Index for the signal.
The Speech Intelligibility Index (SII) is calculated as defined by ANSI S3.5-1997 (R2002), "Methods for Calculation of the
Speech Intelligibility Index". SII is calculated for all signal types.
The principle calculation of SII is as follows: the calculation is applied to third-octave bands, and takes into account the
existing insertion gain. An upward masking is applied for speech and noise.
See also Speech Intelligibility Index (SII) ► 132 for literature references regarding SII.

4.8.4

Deleting stored curves
To delete one or more curves, hover the mouse over the line in the Legend box for the curve that you want to delete and
then click the right mouse button. You can select one of the following options:

4.8.5

•

Delete curve

•

Delete curve in both sides

•

Delete all curves on this side

•

Delete all curves

Copying curves to the clipboard
You can copy curve data to the clipboard. Then you can paste the data in a spread sheet, such as Microsoft Excel.
To copy one or more curves, hover the mouse over the line in the Legend box for the curve that you want to copy and
then click the right mouse button. You can select one of the following options:
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•

Copy curve to clipboard

•

Copy curve in both sides to clipboard

•

Copy all curves on this side to clipboard

•

Copy all curves to clipboard
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4.8.6

Viewing fitting details for a measurement
When you view a measurement from a previous session, for example Aided Response, you can view the fitting details that
were used to calculate the target curve. To view the fitting details for a curve:
•

Click the Fitting Details icon on the corresponding line in the Legend box. SeeThe curve
legend ► 48.

Applying fitting details to current settings
When you open a measurement from a previous session with the same patient, the settings from the latest measured
curve will be applied automatically to your current fitting details. If you want to use the fitting details from another curve,
you can apply those settings. To do so:
•

In the Fitting Details window with the settings you want to reuse, click the Apply button, and then click OK.
The fitting details of the selected curve will be applied to the current fitting details settings. However, when you start
a new session, your start-up settings will be re-applied.

To use the fitting details from a previously measured curve, you can apply them to the current settings, and then:

4.8.7

•

Either: Make a new PMM measurement by clicking Otosuite > New PMM (if you are running Otosuite under Noah) or
File > New PMM (if you are running Otosuite in stand-alone mode);

•

or: Save the settings as a User Test.

Viewing probe tube calibration results
When you view a measurement, for example, from a previous session, you can view the results of the probe tube calibration that was performed before the measurement was made.
•

4.8.8

To view the probe tube calibration, click the Tube Calibration tab in the legend box.

Viewing measurement curves in dB(A)
In FreeStyle, you can see measurement curves displayed with a dB(A) weighted scale instead of the standard dB scale. In
order to display the curve in dB(A), Otosuite uses a standard conversion table to weight the level at each frequency.

Viewing curves in dB(A)
1. In the Options window, select PMM > FreeStyle > View, Graph Settings.
2. In the Frequency Weighting field, select A Weighting.
3. In the FreeStyle screen, make sure that the SPL view is selected.
When A Weighting is selected, the graph label indicates that the curve is displayed in dBA. The legend box contains the
following information:

50

Aurical FreeFit

4 Making Probe Microphone Measurements and coupler based fittings with FreeFit and PMM

A. The level of the presented stimulus in unweighted dB.
B. The average level measured at the eardrum for the duration of the stimulus, in dB(A).
C. The peak level measured at the eardrum, in dB(A).

Reports
If you print a report for the FreeStyle test module while the A Weighting option is selected, it will be reflected in the
report. The label of the graph in the report indicates whether the values are shown in dB or dB(A).

4.9

Aided Response - Example
In the following you will find an example of how to fit a hearing instrument and validate audibility:
1. Make an initial sequence of measurements, with soft, average and loud levels, plus MPO. See Recording a sequence of
measurements ► 45.
2. Compare each of the measurement curves to the corresponding target curves and make initial adjustments to the hearing instrument.
3. While you fine tune the hearing instrument, view a display of the STASS curve. Use the Loop functionality and the first
measurement button to see real-time feedback while you make adjustments to the hearing instrument. You can display the graph in On Top mode while you use the hearing instrument’s software. See Displaying a real-time Aided
Response measurement ► 46.
4. When you believe the adjustment is correct, click the Finalize Measurement button to make an LTASS measurement
so that you can validate that the fitting meets the fitting prescription. See Creating and storing an LTASS measurement
while in Loop mode ► 46.
5. Repeat steps 2 - 4 for each of the measurement buttons, except MPO.

4.10

RECD
When you configure the fitting rule, you choose whether you want to use a measured Real Ear Coupler Difference (RECD)
or a predicted or custom average RECD.
You can specify your preference in the Fitting Details window, in the Applied RECD field. The selected RECD values are
applied to the target curves when you make a coupler based fitting. The RECD values are also used for the HL/SPL conversion for Real Ear mode.

4.10.1

Measuring RECD
RECD values are calculated as the difference between the coupler response and the ear response.
Depending on how your PMM module is configured, you may be required to make a new coupler measurement every
time you make a new RECD measurement. Otherwise, you can store the coupler measurement for reuse.
The coupler measurement is stored on the probe, so that it is always available, even if you use the device with a different
computer. The following information is stored on the probe: date and time of the coupler measurement, and results for
one-third octaves as well as the frequencies 125, 250, 500, 750, 1K, 2K, 3K, 4K, 5K, 6K and 8K Hz.

Measuring the coupler response
You can skip this step if you have a stored coupler measurement. RECD measurements made with either an HA-1 or an HA2 coupler can be stored on the probe. If there is a coupler measurement, the date of the stored coupler measurement for
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each probe appears under the Coupler Response... link.
If you need to make a coupler measurement, follow this procedure:
1. Open the RECD tab in PMM.
2. Under RECD Type, indicate the type of coupler adapter you are using, and whether you are using an earmold or foam
insert tip.

Note • You must use the same RECD probe type for both ears.

3. Attach the right RECD ear probe to the coupler in Aurical® HIT, according to the following instructions:
–

Connect the BTE adapter and tubing to the coupler.

–

Connect the transducer tubing with RECD coupling to the probe transducer port on the probe housing.

–

Place the probe housing in Aurical® HIT and connect the RECD coupling to the BTE tubing (for HA-2) or directly to
the earmold or insert tip (for HA-1). See the pictures below:

HA-2 Coupler

A.
B.
C.
D.
E.

RECD coupling
BTE tubing
HA-2 adapter (BTE)
Transducer tubing
Transducer tube port

HA-1 Coupler

A.
B.
C.
D.
E.
F.

RECD coupling
Foam insert tip
Acoustic putty
HA-1 adapter (ITE and others)
Transducer tubing
Transducer tube port

4. Click Coupler Response... in the RECD control panel.
5. Click the Measure Right button for the right probe.

Note • Mono mode:
If you only have one RECD probe, Otosuite automatically goes into Mono mode, and only the RECD probe is active.
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Mono mode also applies if you have one standard RECD probe and one pediatric (extended) probe; then, only the pediatric probe is active. In Mono mode, only the Measure Right button or Measure Left button is enabled, depending
on which probe is the active probe.
If Otosuite is in Mono mode, measure the relevant probe, and skip steps 6 - 7.
See also Working with a single RECD probe or in Mono mode ► 54.

6. Connect the left probe to the coupler in the Aurical® HIT, as described in step 3.
7. Click the Measure Left button for the left probe.
8. Click OK to close the dialog.
9. Remove the probe from Aurical® HIT and remove the RECD coupling from the BTE tubing or remove the earmold or
foam insert tip from the HA-1 coupler.

Measure the real ear response:
1. Attach the probes to FreeFit.
2. Perform probe tube calibration: Launch the wizard from the toolbar. In RECD, pressing the power button starts an ear
measurement.
3. Connect the transducer tubing to the earmold tubing (or foam insert tip) as follows:
–

Insert the RECD coupling into the tubing of the custom earmold (or a foam insert eartip, if the earmold is not available). The other end of the transducer tubing should still be connected to the probe transducer port on the
probe housing.

A. Transducer tubing
B. RECD coupling
C. earmold or foam insert tip

D. Transducer tube port
E. Probe tube

4. Place FreeFit around the client’s shoulders.
Alternatively, for a baby, seat the baby on the parent’s lap and place FreeFit around the parent’s shoulders. Take the
probe housing off of the headset and clip the probe to the baby’s clothes.
5. Place the probe tubes in the client’s ears together with the earmolds or foam
insert tips. For more information about preparing the client and inserting the
probe tubes, see Preparing the patient ► 19.
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6. In the toolbar, select Left, Right or Both ears. If you only have one RECD probe, see Working with a single RECD probe
or in Mono mode ► 54.
7. Click the Ear Response button. Alternatively, you can briefly press the power button on FreeFit to start the measurement by remote control.

Note • Remote control of ear measurement only works for RECD. In all other PMM test screens, pressing the power
button on FreeFit will initiate the probe tube calibration.

The measured ear response and the RECD are displayed in their respective graphs. RECD is only displayed after both the
real ear response and the coupler response measurements have been made.
The RECD is calculated as Ear response minus Coupler response. RECD values are calculated and displayed graphically for
one-third octave frequencies. The Measured RECD table below the graphs displays the RECD values for the frequencies
125, 250, 500, 750, 1k, 2k, 3k, 4k, 5k, 6k and 8k Hz.

4.10.1.1

Working with a single RECD probe or in Mono mode
If you have a single RECD probe, you can either:
•

Measure one ear and then apply the RECD calculation to both ears, or

•

Measure one ear and then the other.

Measuring one ear and then applying the RECD calculation to both ears
You can do this regardless of which type of RECD probe you are using. See Applying one RECD calculation to both ears ►
54

Measuring one ear and then the other in Mono mode

Note • If you only have one RECD probe, the PMM module automatically goes into Mono mode, and only the RECD
probe is active. Mono mode also applies if you have one standard RECD probe and one pediatric (extended) probe;
then, only the pediatric probe is active. In mono mode, you cannot select both ears.
When PMM is in mono mode, the active probe will be indicated in the graph.

1. Select the ear that you are going to measure.
It does not matter whether the RECD probe is plugged into the right or left side of FreeFit - you
can use it for either ear, and the data will be applied according to your ear selection.
2. Place the probe in the selected ear.
3. Click the Ear Response button to measure.
4. Move the probe to the opposite ear, change ear selection and click Ear Response.

4.10.1.2

Applying one RECD calculation to both ears
If you only have the possibility of measuring the response in one ear, you can select the ear that you want to measure, and
select the Apply the RECD to both ears check box in the control panel, before you click Ear Response. Alternatively,
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after you measure the ear or manually enter RECD values for one ear, you can copy the curves from one ear to the other.
•

4.10.1.3

To do this, right click the legend for the "good" measurement, and then click Copy RECD data to opposite ear.

Swapping measurements
If you measure the left ear with the right probe, and vice versa, you can swap the RECD measurements between the two
ears.
•

4.10.2

To do this, right click the legend for either measurement, and then click Swap RECD data.

Entering RECD values manually
You can enter measured RECD values manually:
1. Click the RECD tab.
2. Click the Add/edit measured RECD icon next to the Measured RECD table for either the left
or right ear, below the graphs.
A window opens in which you can enter the values for the selected ear.
3. Click in a table cell and enter the RECD value for the indicated frequency. Use the tab key to move to the next cell.
4. When you have entered all of the values, click OK.
The RECD curve is displayed in the graph.
5. Repeat for the other ear, as needed.

4.10.3

Using a stored RECD
Note • If you use RECD measurements that have been made in a REM application other than Otosuite PMM, the RECD
Type from the currently loaded Fitting Details is applied.

•

To browse RECD measurements stored in Noah for the client, click the Browse Previous Measured RECD Data icon on the toolbar.
You can apply values from one session to the left ear, and values from another session to the right ear, for example.
However, you cannot mix measurements using different RECD types - you must use the same RECD type for both ears.

4.11

Unaided response
When you configure the fitting rule that you use to calculate the fitting prescription, you choose whether you want to use
a measured Real Ear Unaided Gain (REUG), a predicted REUG, or an average or custom average REUG. You specify your preference in the Fitting Details window, in the Applied REUG field.
You can use the Unaided Response test screen to make a REUG measurement. If you measure unaided response, the
Applied REUG will automatically be switched to Measured REUG.
The calculation of the Real Ear Insertion Gain (REIG) and the target curves depend, in specific instances, on the REUG. The
used REUG does not impact target calculation if the unaided thresholds (reference audiogram) were measured using insert
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phone, headphone, or ABR transducers. This means that calculation of targets only takes the REUG into account when
unaided thresholds were measured using sound field.

4.11.1

Fitting prescriptions and REUG
REUG is handled differently depending on which fitting prescription you have selected in the Fitting Details dialog.

Note • For all fitting rules, calculation of targets only takes the REUG into account when unaided thresholds were
measured using sound field,

If you have selected NAL
•

REUG has no effect on the target insertion gain or target Real Ear Aided Gain (REAG).

If you have selected DSL
•

If the REUG has been measured at 0° azimuth, the measured or entered REUG values are used to derive thresholds.
This will affect your REAR target calculations and it will affect REIG targets.

Note • The calculation of REIG only takes REUG into account if the REUG was measured at 0° azimuth.
If the REUG is measured at other than 0° azimuth, DSL does not use the measured REUG to calculate REIG. In that
case, DSL substitutes age-appropriate average values for 0° azimuth for calculation of REIG targets.

Note • If you measure REAR and then measure REUG (at 0° azimuth), you will end up with different REIG targets
than if you measure REAR and use a KEMAR REUG.

•

If hearing is measured in sound field with 45° azimuth for loudspeakers and the REUG is measured at 45° azimuth, DSL
uses the measured REUG to derive thresholds and this will affect your REAR target calculations.

•

If hearing is measured in sound field with 90° azimuth for loudspeakers and the REUG is measured at 90° azimuth, DSL
uses the measured REUG to derive thresholds and this will affect your REAR target calculations.
Effects of Measured REUG on calculation of REAR targets and REIG targets in DSL
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Hearing measured at

REUG measured at 0°

REUG measured at 45°

REUG measured at 90°

0°

REUG affects REAR targets;
REUG affects REIG targets

N/A

N/A

45°

N/A

REUG affects REAR targets;
Average values used for
REIG

N/A

90°

N/A

N/A

REUG affects REAR targets;
Average values used for
REIG
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4.11.2

Measuring unaided response
The Unaided Response test screen is similar to the Aided Response test screen, but with fewer functions. For example,
there is only one measurement button in Unaided Response, and there is no Loop function.
The following functionality in Unaided Response is the same as described for Aided Response:
•

Selecting and displaying a reference audiogram. See Selecting and displaying a reference audiogram ► 27.

•

Configuring the measurement button. See Configuring measurement buttons in PMM ► 36.

•

Specifying what is shown in the work area. See Specifying what to show in the graphs ► 38.

When you click the measurement button in Unaided Response, the signal assigned to the button is played, and the measurement curve is displayed in the graph.
The curve legend in Unaided Response functions the same as the curve legend in Aided Response. See Viewing recorded
measurements ► 48.

4.12

Measuring occluded response
You can use the Occluded Response test screen to measure the client’s response with the hearing instrument in the ear
but not turned on. By comparing the Real Ear Aided Gain (REAG) with the Real Ear Occluded Gain (REOG), you can find out
to what extent the hearing instrument blocks out sound from the ear canal.
It can be assumed that sound passing the hearing instrument to get into the ear is proportional to the amount of sound
that escapes past the hearing instrument from inside the ear. It is useful to know how much sound escapes from the ear, in
order to predict feedback problems.
You can use this information to determine whether vents in the hearing instrument are sized appropriately.
The Occluded Response test screen is similar to the Aided Response test screen, but with fewer functions. For example,
there is only one measurement button in Occluded Response, and there is no Loop function.
The following functionality in Occluded Response is the same as described for Aided Response:
•

Selecting and displaying a reference audiogram. See Selecting and displaying a reference audiogram ► 27.

•

Configuring the measurement button. See Configuring measurement buttons in PMM ► 36.

•

Specifying what is shown in the work area. See Specifying what to show in the graphs ► 38.

When you click the measurement button in Occluded Response, the signal assigned to the button is played, and the measurement curve is displayed in the graph.
The curve legend in Occluded Response functions the same as the curve legend in Aided Response. See Viewing recorded measurements ► 48.

4.13

Verifying the performance of the noise reduction feature in the hearing
instrument
You can use the Noise Reduction test screen to verify that the noise reduction feature on the hearing instrument is working, and to demonstrate the noise reduction feature to the client.
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The control panel in Noise Reduction contains three measurement buttons that you can configure to verify or demonstrate noise reduction with three different signal types.
The noise reduction feature in contemporary hearing instruments typically requires quite a few seconds (often 15-20
seconds) of steady noise before it is able to start the attenuation. This period of time is called the adaptation interval.
Each measurement button initiates two measurements, and results in two curves. First, a measurement is made within the
first second, before the noise reduction feature begins to work. Then a second curve is recorded after the adaptation interval has elapsed. At that point, the signal has played long enough to activate the noise reduction feature. After the second
measurement has been made, the difference between the two curves is displayed in an additional graph.
This functionality allows you to verify or demonstrate the noise reduction feature without switching the feature on and off
on the hearing instrument.
The noise reduction feature is typically most effective in the lower frequencies, as the masking effects are lower.
The reduction is not very impressive visually in the graph, since it is typically only a matter of 3-5 dB of attenuation. This is,
however, a very powerful auditory improvement, since it makes a significant difference in improving the signal-to-noise
ratio, which is especially critical for the hearing impaired.
You can alternate which graph is larger by double-clicking in the smaller graph.

4.13.1

Configuring measurement buttons in Noise Reduction
You can configure the buttons in the Noise Reduction control panel in the same way as you configure the measurement
buttons in the Unaided Response, Occluded Response, and Aided Response control panels.

To configure a measurement button in the Noise Reduction control panel:
1. Click the drop-down button to the right of the measurement button that you want to configure.
2. Point to Signal Type and then select the sound file that you want the button to activate.
3. Point to Level, and then select the sound level that you want the signal to be played at when the button is activated.
You cannot select duration for the individual buttons. Instead, you can change the contents of the Adaptation Interval
field.
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Adjusting the Adaptation Interval
The adaptation interval is the length of time, in seconds, that it takes for the noise reduction to begin working. The second
curve recorded by a measurement button in Noise Reduction is recorded after the signal has been played for the length of
the adaptation interval. You can change the contents of the Adaptation Interval field.

Using the ISTS signal to verify Noise Reduction
You can use the ISTS signal (International Speech Test Signal) to verify that the noise reduction feature is activated in varying speech levels. The dB gain difference that results from the noise reduction feature will vary according to the variability
of the signal itself. Because ISTS is a dynamic signal, it can be used for a functional assessment of how the hearing instrument noise reduction algorithm handles speech stimuli, but the absolute dB gain difference values may not be meaningful.
Similarly, snapshots taken with the ISTS signal in FreeStyle may vary due to the signal’s variability.

4.13.2

Verifying and demonstrating noise reduction
Before you can make a measurement in the Noise Reduction test screen, you must do the following:
•

Perform probe tube calibration. See Calibrating the probe tubes ► 18.

•

Configure one or more measurement buttons in the Noise Reduction control panel. See Configuring measurement
buttons in Noise Reduction ► 58.

•

Prepare the client and place the probe tubes in the client’s ears together with the hearing instrument. See Preparing
the patient ► 19.

•

Make sure that the hearing instrument has a noise reduction feature, and that it is enabled.

When you click a measurement button in the control panel, the signal assigned to the button is played. First, a reference
curve is recorded and displayed in the graph. After the adaptation interval has elapsed, a second curve is recorded and displayed in the graph. In a separate graph, a difference curve is displayed. The difference curve shows the difference
between the two curves measured by one measurement button.
If you can see that the noise reduction feature has taken effect before the adaptation interval has elapsed,
you can click the Stop button. When you click Stop, the second measurement is recorded, the signal is
stopped and the curves are displayed.
The colors of the camera icons next to the measurement button indicate the colors of the measurement curves created by
the button.
For information about changing how data is displayed in the Noise Reduction test screen, see Specifying what to show in
the graphs ► 38.

4.14

Using FreeStyle to create your own tests
FreeStyle offers you a number of flexible features that allow you to create your own tests for demonstrating and verifying
hearing instrument features and fitting.

FreeStyle enables you to make measurements using a variety of different sound sources. You can play two signals simultaneously, either from a front speaker and a rear speaker, or from a single speaker. You can make two measurements and
then view a curve that illustrates the difference between the two measurements. A difference curve can be displayed for
measurements made with the following sets of buttons: 1 and 2, 3 and 4, or 5 and 6.
See also The FreeStyle screen ► 78 for an introduction to the buttons in the FreeStyle control panel.
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4.14.1

Configuring the Snapshot Play button and the measurement
buttons in FreeStyle
The control panel in FreeStyle contains the Snapshot Play button and six measurement buttons that can be configured in
the same way as the buttons in Aided Response for the standard sound signals and MPO. The FreeStyle measurement buttons also have additional options for configuration, including additional sound source options and Snapshot functionality.

Sound sources in FreeStyle
You can select from the following sound sources:
•

The sound files that are available in the other test screens in PMM.

•

A large variety of additional sound files.

•

A CD of your choice.

•

A recording that you create. See Making a recording ► 63.
Instead of using a prerecorded speech sound, you can use a speech sound familiar to the client. To do so, make a
recording, for instance of the voice of the third party. This also allows for a higher degree of repeatability than by using
a live voice.

•

Live sound, for example your own voice or the voice of a third party, such as the client’s spouse.
When you use a Live signal, any sound files must be played through an external media player. When you do so, make
sure that you adjust the level according to the VU meters above the graph area.

Configuration of buttons in FreeStyle is described in the following sections:
•

Using a button to play a sound file ► 60

•

Using the Snapshot function ► 62

•

Using a CD as the sound source ► 63

•

Using a recording as the sound source ► 63

•

Using live sound as the sound source ► 64

You can see the configuration settings for a button by hovering the mouse over the button. The settings are displayed in
the status fields in the control panel.
See Configuring measurement buttons in PMM ► 36 for information about MPO, vocal effort, and how to rename a button.

4.14.2

Using a button to play a sound file
The FreeStyle control panel contains a Snapshot Play button and six measurement buttons.
You can configure any of the buttons to play a sound file at the level and duration of your
choice.

To configure a button to play a sound file
1. Click the drop-down button to the right of the button that you want to configure.
2. Select Internal Signal and then point to Signal Type.
3. A “Favorites” list of five signals is displayed - you can select from this short list, or you can click All Signal Types to see
the full list, and then select the sound file that you want the button to activate. To learn how to configure your favorite signals list, see Making your favorite signals list ► 61.
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4. Point to Level, and then select the sound level that you want the signal to be played at when the button is activated.
5. Point to Duration and then select the number of seconds for which you would like the signal to be played.
–

Full Length plays the signal for the full duration of the sound file.

–

Custom opens a window where you can enter the duration in seconds.

Note • Accurate LTASS and percentile measurements require an absolute minimum duration of 10 seconds. 14
seconds is the default setting in PMM to accommodate the signal length of our standard passages.

Making a measurement
Measurement buttons in FreeStyle that play a sound file function in the same way as measurement buttons in Aided
Response. See Performing an Aided Response measurement ► 44

4.14.2.1

Selecting a secondary signal
You can select a primary signal and a secondary signal. If you only have one speaker, both signals will play from the same
speaker. Otherwise, you can choose which signal to route to the front speaker and which to route to the rear speaker.

To select a secondary signal
1. Click the drop-down button to the right of the button that you are configuring. Point to Secondary Signal Type and
then select Internal Signal.
2. In the Secondary Signal Type sub-menu, point to Signal Type and then select a sound file.
3. Point to Relative Level and then select the level of the secondary signal relative to the primary signal. For example, 20 dB means the secondary signal will be 20 dB lower than the primary signal.
4. If your system is configured for two speakers, or if you are in Coupler Based Fitting mode, then a Routing menu item
appears in the button configuration menu. Point to Routing and select one of the options. The primary signal will be
presented in the first-mentioned speaker and the secondary signal will be presented in the second-mentioned
speaker. For example, if you select Front/Rear, the primary signal will be presented in the front speaker, and the secondary signal will be presented in the rear speaker.

4.14.2.2

Making your favorite signals list
In FreeStyle, you can select from a long list of internal sound files. In order to make it easier to find the files you use most
often, a short list of 5 files is displayed when you click Signal Type. You can then click All Signal Types to see the full list.
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A. Configuration menu for measurement button in FreeStyle
B. Full list of signal files
C. Your favorite signal files

Fig. 1

The favorite signals list, and the list of all signals

You can create your own favorite signals list in Options. To configure your favorites list, in the Options window, click PMM
> FreeStyle > Measurement, Favorites. Select a signal for each of the fields (Favorite 1, Favorite 2, and so on). Save the
options as default startup settings or as a user test. For more information about saving options, in the Otosuite manual in
Getting started with Otosuite, see View and measurement options.

4.14.3

Using the Snapshot function
You can use the Snapshot function to capture a measurement at a very specific time in relation to Hearing Instrument (HI)
behavior. You can, for instance, use a snapshot to capture different measurements of HI directionality related to the listening position of the client towards the speaker.

To set up the Snapshot function:
•

Assign a signal, level and duration to the Snapshot Play button. See Configuring the Snapshot Play button and the measurement buttons in FreeStyle ► 60.

•

Configure one or more of the measurement buttons as a Snapshot button. To do so, click
the drop-down to the right of the button and select Snapshot.

If you want to be able to compare two snapshot measurements in Feature-2-Benefit view, configure two buttons as Snapshot buttons. The Snapshot buttons must belong to a pair (1 and 2, 3 and 4, or 5 and 6).

Making Snapshots
Click the Snapshot Play button to play the signal. While the signal plays, you can click a Snapshot button to make a snapshot measurement. The peak hold is reset for each Snapshot measurement.
The captured snapshot curve is displayed as the short term average at the time the measurement is made.
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4.14.4

Using a CD as the sound source
You can use a CD as the sound source for a measurement button.

Selecting a CD drive
Click Measurement > Select CD Drive and then select the drive that you will use to play the CD. It is possible to use a virtual CD drive.

Configuring a button to use a CD as the sound signal
1. Insert the CD in the CD drive.
2. Click the drop-down to the right of the measurement button and select CD, and then select the relevant track on the
CD.

Making a measurement using a CD
1. Click the measurement button that has been configured to play a CD.
2. Adjust the volume using the Master volume slider in the control panel, while
you keep an eye on the VU meter above the graph.

3. Click the Finalize Measurement button to make and store an LTASS measurement.

4.14.5

Using a recording as the sound source
You can make a customized recording for use in FreeStyle. The impact of using a familiar voice as signal is a powerful way
of demonstrating deficits of hearing loss, or the improvements with amplification. Using a recording also allows for repeatability.

Configuring a button to use a recording as the sound signal
•

To configure one of the buttons for recording, click the drop-down to the right of the button and select Recording.
Click Duration and select the number of seconds that you want to play the recording. The button is grayed out until
you create a recording.

Making a recording
1. Make sure that appropriate reading material is readily accessible. It is recommended that familiar texts
such as newspaper articles are used, so that the talker does not have to rely on improvisation.
2. Set the table-top microphone at a distance of approximately 30 centimeters (10 inches) from the
mouth. While you or a third party talk at a steady level, use the Microphone Sensitivity slider control
in the control panel to adjust the microphone sensitivity, so that the control panel VU-meter is kept at
the desired level.
3. Start the recording by clicking the Make Recording button. Read the text keeping the strength at the
same steady level throughout the recording. About 10-15 seconds of recording may suffice.
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4. The button becomes a Stop button. Click the Stop button when you want to stop recording.

Making a measurement with a recording
•

Click the measurement button to play the recording.

The recording plays for the duration that the button has been configured for, or the length of the recording, whichever is
shortest, and then an LTASS measurement is stored.
You can also click the Finalize Measurement button to restart the signal and store a measurement.

4.14.6

Using live sound as the sound source
To configure a measurement button to use live sound as the sound source:
•

Click the drop-down button to the right of the measurement button and select Live.

Making a measurement with a live signal:
•

Click the measurement button that has been configured for a live signal.

•

The person speaking can adjust the volume of his or her voice to the desired level by watching the VU meter while
speaking.
The curve is displayed in the graph. When you click Stop, the measurement curve is stored.

4.14.7

Viewing measurements in FreeStyle
After storing one or more measurement curves, you can see the curves in the graph, and you can see additional data in the
Legend box.
To compare two paired measurements, you can click the Feature-2-Benefit icon. An additional graph is displayed. For each pair of curves that is selected in the Legend box, a difference curve is displayed in the
Feature-2-Benefit graph.
For more information about the information that is displayed in the graphs and in the Legend box, see Viewing recorded
measurements ► 48 and Specifying what to show in the graphs ► 38.

4.15

Using FreeStyle with Aurical® HIT to test hearing instruments with
wireless transmitters (e.g. FM)
This procedure applies to hearing instruments with FM functionality. Use the procedure to verify that the FM system is correctly adjusted for transparency and FM advantage.
The FM verification measurements (reference, transparency and FM advantage measurements) involve coupler measurements both inside and outside the test chamber.

What you need for testing
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•

Aurical® HIT

•

An FM transmitter

•

Hearing instrument with FM receiver

•

Coupler assembly (adapter, coupler cavity and coupler microphone) placed in Accessory Box
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•

Coupler cable between Accessory Box and Aurical® HIT

•

Insulating pad under Accessory Box

•

Acoustic putty (sealing material), such as Bostik Blu-Tack™

The measurement procedures described below serve as a guideline to show the intended workflow. This includes a
description of how to use the two special tests for FM Sequence testing with the Feature-2-Benefit functionality in the Otosuite PMM module.
For detailed instructions on FM and hearing instrument settings, as well as interpretation of these measurements, see the
documentation provided by the manufacturer of the specific FM device.
Use the two special tests for FM testing in the Otosuite PMM module. You can use these tests to automatically collect and
compare the relevant measurements for FM transparency and advantage. These special tests are based on a traditional
65 dB SPL speech signal for reference and transparency, and an 80 dB SPL speech signal for FM advantage.

Perform reference measurements
1. To perform reference measurements, position the hearing instrument as described in in the Aurical® HITUser Guide.
Leave the hearing instrument placed on the coupler assembly in Aurical® HIT.
2. Set the hearing instrument to FM+HI mode.
3. Make sure that only the hearing instrument receives an input signal by muffling the FM transmitter microphone.
4. In the Otosuite Test Selector select the special test FM Reference Sequence - HI in Aurical® HIT on the PMM tab.
The FreeStyle test screen in PMM is launched.
5. Close Aurical® HIT and click the Sequence button in the Control Panel to measure curves 1 and 3.

Perform FM transparency and FM advantage measurements
1. Connect the coupler cable from the Accessory Box to Aurical® HIT.
2. Place the hearing instrument setup in the top position coupler hole of
the Accessory Box and place the Accessory Box on an insulating pad to
prevent noise and vibration from influencing the test.

3. Raise the elevation plate in the test chamber.
4. Make sure that you have removed the material used to muffle the FM
transmitter microphone for the reference measurements.
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For FM transmitter with built-in microphone:
–

Place the FM transmitter on the elevation plate in the test chamber. If the transmitter has two or more microphones for directionality, align them along the loudspeaker axis.

For FM transmitter with lapel microphone:
–

If the FM transmitter is equipped with a lapel microphone, run the
cable into the test chamber and fix the microphone to the elevation
plate.

5. Position the reference microphone as close as possible to the microphone of the FM transmitter, but without touching.
6. In the Otosuite Test Selector select the special test FM Transparency
& Advantage Sequence - HI outside Aurical® HIT on the PMM tab.
7. Close the lid and click the Sequence button in the Control Panel to
measure curves 2 and 4.
8. Check the results in the dB Gain Difference graphs in the Feature-2Benefit view.

4.16

Feedback Finder
All test screens in PMM contain the automatic Feedback Finder, both in response view and gain view.
Feedback is recognized as a sharp peak in the measurement curve. If feedback is detected for a minimum of 128 ms, a flashing dot appears at the frequency of the feedback, and the text Feedback detected appears next to the dot. The alert is displayed for the duration of the feedback and for two seconds after the feedback is no longer detected.
The feedback alert indicates the frequency of the feedback at 1/24 octave resolution. However, the measurement curve in
Aided Response, Unaided Response and Occluded Response, only has 1/3 octave resolution, so the feedback is represented in the curve at the closest 1/3 octave. Therefore, the alert dot does not always appear on the peak curve.

Note • If the feedback is detected in the middle of two 1/3 octaves, it is represented in both 1/3 octave values.

If you want to see a higher resolution measurement curve (with the measurement curve, including feedback peaks, in 1/24
octave resolution), you can use FreeStyle.
If multiple feedback peaks or harmonics are detected, each feedback peak is indicated by an alert symbol.
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If the feedback is outside the visible area of the graph, for example if you have zoomed in on the graph, then the graph will
automatically zoom out to display the alert.

Note • Feedback Finder is not available in Coupler Based Fitting mode.

4.16.1

The Feedback Finder dialog
By default, Feedback Finder is set up to pause the signal and measurement, and display a message, when feedback is
detected. The message offers the following options:

4.16.2

•

Stop and store the current measurement to store the curve containing feedback for comparison after adjustments
have been made

•

Resume the currently paused measurement to make offline adjustments and resume measurement

•

Reset and create a new measurement to restart with a clean measurement

Setting up Feedback Finder
In the Options window, you can set up Feedback Finder.

Determining how feedback detection is handled
1. In the Options window, click PMM > General > Measurement - Misc.
2. In the Feedback Detection behavior field, select one of the following options:

4.17

–

Off - to disable Feedback Finder.

–

Ask me what to do - to pause the measurement when feedback is detected and display a dialog box, as described
in The Feedback Finder dialog ► 67

–

Continue - to display an alert in the graph when feedback is detected and continue measurement.

–

Stop - to stop when feedback is detected and store the measurement.

Occluded Probe-Tube Detector
The Occluded Probe-Tube Detector protects you from making measurements under poor conditions by alerting you when
a tube is pinched or blocked.
If a message appears telling you that a probe tube is occluded, reposition the tube to clear the occlusion, and remake the
measurement.

Activating or deactivating the Occluded Probe-Tube Detector feature
In the Options window, in PMM > General > Measurement, Misc > Occluded Probe-Tube Detector, select On to activate the feature, or Off to deactivate the feature.

Note • Occluded Probe-Tube Detector is not available in Coupler Based Fitting mode.
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4.18

Monitoring the signal at the eardrum (or in the coupler)
In all test screens in PMM, you can access the Listen at the Eardrum/Listen in the Coupler window, which you can use to
monitor the signal at the client’s eardrum or in the coupler. You use headphones to hear the signal that is picked up by
the microphone in the probe tube.
You can use this functionality, for example if the client complains that the hearing instrument is creating unwanted sound.
You can present to the client either a recorded signal from a sound file, or live input.
You can listen to the signal at the same time as the client is hearing it, and you can record the signal at the client’s
eardrum or in the coupler and then play it back.

Monitoring the signal at the eardrum or coupler using live input
1. Click the Listen at the Eardrum/Listen in the Coupler icon to open the Listen at the Eardrum/Listen
in the Coupler dialog.
2. Click the Live icon.

3. Select the ear to monitor. You can only monitor the signal in one ear at a time.
4. Click the Play button.
You can talk to the client, or you can have the third party talk to the client. The microphone in the
probe tube picks up the signal at the client’s eardrum and plays it through the headphones. A recording
of the signal is also made.
5. Use the Monitor Level slider to adjust the level of the output in the headphones.
You can click the Pause button to pause and restart the recording as needed.

6. Click the Stop button to stop the recording.

Monitoring the signal at the eardrum or in the coupler using a sound file
1. Click the Listen at the Eardrum/Listen in the Coupler icon to open the Listen at the Eardrum/Listen
in the Coupler dialog.
2. Click the File icon.

3. Select a level in the Intensity field.
4. Select a file in the Title field.
5. Select the ear to monitor. You can only monitor the signal in one ear at a time.
6. Click the Play button.
The sound file is played through the speaker. The microphone in the probe tube picks up the signal at
the client’s eardrum and plays it through the headphones. A recording of the signal is also made.
7. Use the Monitor Level slider to adjust the level of the output in the headphones.
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You can click the Pause button to pause and restart the recording as needed.

8. Click the Stop button to stop the recording.

Playing a signal that has been recorded at the client’s eardrum or in the coupler
1. In the Listen at the Eardrum/Listen in the Coupler dialog, click the Play Recording button.

2. Click the Play button.
The last recorded signal is played through the headphones.
3. Use the Monitor Level slider to adjust the level of the output in the headphones.
You can click the Pause button to pause and restart the play back as needed.

4. Click the Stop button to stop the signal.

The recorded signal is overwritten when you make a new recording in the Listen at the Eardrum/Listen in the Coupler
window. The recording is deleted when you close Otosuite.

4.19

Printing reports in PMM
In general, reports in PMM are similar to reports in other modules in Otosuite. You can print reports in PMM from the
Reports menu, and you use the Report Manager to manage the list of reports that appear in the Reports menu. See the
Otosuite manual for more information about general report functionality.
Each report related to a PMM test screen contains a graphic presentation of the test data, plus the information from the
Legend box. In addition, you can choose between two types of reports, Comments and Tabular:
•

Comments
In addition to the graph and Legend box, the report includes any comments that you have entered for the lines in the
Legend box.

•

Tabular
In addition to the graph and Legend box, the report includes a table containing the same data as the graph, but
presented as numerical values.

4.19.1

Designing your own reports in PMM
PMM reports closely resemble what you see on the screen. The overlays and views that have been selected in a test
screen are included in the reports for that test screen. By changing how information is presented on the screen, you also
change the appearance of the PMM reports.
You can do the following:
•

Aurical FreeFit

Design different reports based on the same report template by changing the settings, either using the control panel
and toolbar, or using the Options window.
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•

4.20

Save the settings for each report as a user test. In the Options window, click Save User Test. For more information
about saving options, in the Otosuite manual in Getting started with Otosuite, see View and measurement options.

Making new measurements
When you use Otosuite with Noah, all measurements that you save for a client made on the same day are saved in a single
session. If you want to save more than one measurement of a specific type - for example 2 audiograms, or two unaided
measurements for the same ear - you can save them as separate actions within the session.

To make a new Action:
1. Click OTOsuite >New > PMM.
2. In the dialog that appears, indicate whether you would like to keep any PMM data from the currently loaded measurements, or create an empty action.

4.21

–

When you indicate you would like to keep PMM data, i.e. you will make the new measurements based on existing data, the reference audiogram used from that data is persisted and used for the remainder of the session.

–

When you start a new session or make a new empty action, Otosuite PMM automatically uses the most recent
audiogram. Unless you actively select a different reference audiogram, PMM continues using the same reference
audiogram for the rest of the session - even if you make a new audiogram and create a new action.

–

If you load a session from a previous day and then click OTOsuite > New > PMM, the reference audiogram is automatically set to the most recent audiogram, unless you choose to make measurements based on the loaded session, i.e. if you do not create an empty action, or actively select a different reference audiogram.

Setting Maximum SPL at the Eardrum
You can select a maximum output level for signals played in PMM. This will ensure that the SPL at the eardrum does not
exceed the level that you select. The maximum level is defined in relation to the UCL. You can select a level between
UCL+5 and UCL -15.
To select the maximum level, click Tools > Options > PMM. The Max SPL at TM field is under Measurement.

Note • The PMM module does not contain different symbols for Response and No Response values. No Response points
in the UCL threshold are treated as measured UCL points for the purpose of limiting output. Missing points are interpolated for the purpose of limiting output.
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Navigating in PMM
The general functions for navigating in the main window are described in the Otosuite manual.

General icons - see the Otosuite manual

The icons and menu items that are unique to PMM functionality are described in:
PMM menus and toolbar icons ► 71
You will find descriptions of the PMM test screens in:
The Unaided Response screen ► 76
The Occluded Response screen ► 76
The Aided Response screen ► 76
The FreeStyle screen ► 78
The Noise Reduction test screen is described in Verifying the performance of the noise reduction feature in the hearing
instrument ► 57

5.1

PMM menus and toolbar icons
The icons available in the toolbar depend on the test function that you have selected.

PMM icons

The menu selections and toolbar icons specific to PMM are described in the following:

View menu
PMM menu items only. See the Otosuite manual to read about general functionality.
Response, Gain, REIG and PAA
Toggle between Response, Gain, REIG and PAA view
Click the icon in the toolbar to toggle between the various views, or click the menu item to select the
view.

Response

Gain

Aided Response only:
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Response, Gain, REIG and PAA
Select REIG to view the Real Ear Insertion Gain, which is calculated as the difference between the client’s REAG and the client’s REUG. The REUG is either measured or predicted, depending on the
option selected in the Applied REUG field in the Fitting Details window. See Applied REUG ► 31.
Select PAA to view the Predicted Aided Audiogram, which applies the measured REIG to the client’s
unaided threshold to estimate what the client’s aided thresholds might be, if functional gain assessment was performed.

HL
SPL
Toggle between HL and SPL view
Click the icon in the toolbar to toggle between the views, or click the menu item to select the view.
Select HL to view the Hearing Level view. Select SPL to view the Sound Pressure Level view.

Left
Select the icon or menu item to view the graph relating to the left ear.

Right
Select the icon or menu item to view the graph relating to the right ear.

Left + Right (Both)
Select the icon or menu item to view the graph relating to both ears.

Overlays
Select the overlays that you want to display in the graph.
For more information about overlays, seeSpecifying what to show in the graphs ► 38.

Legends
Show/hide Curve Legend and Overlays box
Click the icon or menu item to show or hide the Legend and Overlays box.
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On Top Window
Switch to On Top mode
Select to view the PMM screen in a down-scaled version for use on top of other applications, for
example hearing instrument fitting software. Click the icon or close the window to return to normal
viewing. See On Top mode in PMM ► 80 for more information.

Feature-2-Benefit
Switch to Feature-2-Benefit view
In FreeStyle, select Feature-2-Benefit view to display one additional graph in monaural view, or two
additional graphs in binaural view. Each additional graph contains up to three curves that show the difference between paired measurement curves. The RMS difference between the curves is shown in the
curve legend.

Measurement menu
PMM menu items only. See the Otosuite manual to read about general functionality.
Fitting Details (F10)
Click the icon or menu item, or press F10 to edit the parameters for a target rule.
See Validated fitting prescriptions ► 28.

Select CD Drive
Select the drive that you want to use to play CDs when you select CD as the sound source in FreeStyle.

Stop (Esc)
To stop a test, select the menu item, press Esc, or click the Stop icon on the control panel.

Start Sequence (F5)
To start a measurement sequence, click the Sequence button in the control panel, or click the menu
item in the Measurement menu.
If you have selected the measurement buttons for a sequence, you can start the sequence by pressing
F5.

<Name of Measurement Button> (Ctrl+1 - Ctrl+6)
To start a measurement, click the measurement button in the control panel, or click the menu item in
the Measurement menu.
Alternatively, you can press Ctrl+1 for the first measurement button, Ctrl+2 for the second measurement button, and so on.
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Reference Audiogram
To select an audiogram for the basis of the fitting, click the menu item. See Selecting and displaying a
reference audiogram ► 27.

Listen at the Eardrum/Listen in the Coupler
Click the icon to open the Listen at the Eardrum/Listen in the Coupler window, which you can use to
record the signal at the client’s ear drum or in the coupler, or monitor the signal through your headphones.
See Monitoring the signal at the eardrum (or in the coupler) ► 68.

Browse Previously Measured RECD Data
To select previously measured RECD values for the basis of the current fitting, click the icon.
See Using a stored RECD ► 55.

Coupler based fitting/Real Ear based fitting
The icon indicates the current fitting mode. Click the icon to toggle to another fitting mode.
See Making a coupler based measurement using Aurical® HIT ► 45.

Note • Real Ear SPL and Coupler Based SPL measurements are not displayed together in the same
view.

Tools menu
PMM menu items only. See the Otosuite manual to read about general functionality.
FreeFit Calibration
Probe Tube
To calibrate the silicone probe tubes used during testing, click the menu item or icon. See Calibrating
the probe tubes ► 18.
Reference Microphone
FreeFit reference microphone calibration must be performed by a certified service technician.
Room
To calibrate the speaker system and headphones used in the test setup, click the menu item. See Performing a room calibration ► 17.
OpenREM
See Making OpenREM/Stored EQ measurements ► 47 for information about when and how to use
OpenREM calibration.
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Aurical® HIT Calibration
Stored EQ
See Making OpenREM/Stored EQ measurements ► 47 for information about when and how to use
Stored EQ.
Reference Microphone
You should calibrate the reference microphone in Aurical® HIT regularly. See the
Aurical® HITReference Manual for instructions.
More
Additional types of calibration must be performed periodically by a certified service technician. See
the Aurical® HITReference Manual for more information.

Select Device
Click the icon to open the Select Device window, which you can use to select a FreeFit device. This is
useful if you have more than one device. See also Selecting a FreeFit device ► 44.

Live Video Otoscopy
If you have Otocam connected and turned on, you can click the icon to open the Live Video Otoscopy
window on top of your PMM window. This is useful to monitor the placement of the probe tube, for
example. Note that this on-top function allows you to view live video only, and you cannot store or
annotate images. See also Fitting FreeFit and probes on the client ► 20.

ProbeTube Assistant
Click to open the Probe Tube Assistant for placing the probe tube in the ear canal. See also Inserting
the probe tubes ► 1.

5.2

Viewing PMM graphs: Zoom and Pan
Zoom
You can use the zoom function to get a more detailed view of curves in PMM. To zoom in a graph, hover the cursor over
the graph and turn the mouse’s scroll wheel. If the mouse does not have a scroll wheel, press Ctrl while you move the
cursor up over the graph. To zoom out again, press Ctrl while you move the cursor down over the graph.

Pan
When you use the zoom function on a graph, only part of the graph is visible. Then you can use the Pan function to view a
different part of the graph. To pan, press the left mouse button while you move the cursor over the graph.
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5.3

Displaying the distance between points on a graph
In PMM, you can display the difference between two points on a graph by hovering the cursor over a point on the graph
and then pressing the right mouse button while you drag the cursor to another point on the graph. The difference
between the two points, both on the x-axis and the y-axis, is displayed in red text as long as you continue to depress the
mouse button.

5.4

The Unaided Response screen
You use the Unaided Response test screen to make probe microphone measurements in the client’s ear while the client
is not wearing a hearing instrument, for the purpose of measuring the Real Ear Unaided Response (REUR), or the Real Ear
Unaided Gain (REUG).
The REUG is used by the target rule to calculate the fitting prescription, which you can display in the Aided Response test
screen. In the Fitting Details window, in the Applied REUG field, you specify whether you want to use a REUG that is
measured, average or custom average.
For more information, see Unaided response ► 55.

5.5

The Occluded Response screen
You use the Occluded Response test screen to make probe microphone measurements in the client’s ear while the client
is wearing a hearing instrument that is not turned on, for the purpose of measuring the Real Ear Occluded Response
(REOR), or the Real Ear Occluded Gain (REOG).
You can use the REOG to determine how much sound gets past the hearing aid, in order to determine whether the vents
in the hearing aid are sized appropriately.
For more information, see Measuring occluded response ► 57.

5.6

The Aided Response screen
Use the Aided Response test screen to make probe microphone measurements in the client’s ear while the hearing instrument is turned on, for the purpose of fitting the hearing instrument and validating audibility.
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A. Control panel with Aided
measurement buttons
B. Loop function check box
C. VU Meter
D. Curve Legend
E. Measurement curves and target curves
F. Finalize Measurement button

The Aided Response control panel
The control panel in Aided Response contains the following elements:
Sequence button (F5)
If you have selected the check box next to two or more measurement buttons, you can
click the Sequence button to make a sequence of measurements.
See also Recording a sequence of measurements ► 45.
Loop check box
Select the Loop check box to play one signal in a continuous loop. When you click a measurement button, the signal plays and the measurement curve displays the short term average of the signal at the probe tube.
Click Stop to stop the signal or click the Finalize Measurement button to record an LTASS
recording.
See also Displaying a real-time Aided Response measurement ► 46.
Finalize Measurement button
Click the Finalize Measurement button to restart the current signal and record an LTASS
measurement.
Measurement button
Configure the signal, level and duration that will be played by the button.
Click the button to play the signal and record a measurement.
See also Configuring PMM measurement buttons and test screens ► 36 and Performing an
Aided Response measurement ► 44.
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Status fields
The Status fields in the control panel display the signal type, level and duration for a measurement button when you hover the mouse over the button. When you activate a measurement button, the signal type and level are displayed and the duration is counted down.
For more information, see Performing an Aided Response measurement ► 44.

5.6.1

The Predicted Aided Audiogram View
Dotted Line = Target Aided Threshold
Solid Line = Predicted Aided Audiogram

In the Aided Response test screen, you can select the Predicted Aided Audiogram view. The purpose of this view is to
illustrate that the client has improved access to the sound signal with the hearing instrument. In the PAA view, two curves
are displayed:
•

The Target Aided Threshold curve is a static curve based on the selected target rule. The Target Aided Threshold is
the unaided threshold less the target gain for the selected signal according to the selected target rule. TAT = unaided
threshold - target gain.

•

The Predicted Aided Audiogram is a live curve based on the actual measured gain. The Predicted Aided Audiogram is
the unaided threshold less the measured insertion gain. PAA = unaided threshold - measured REIG.

If the hearing instrument is adjusted correctly, the two curves should be very similar.

5.7

The FreeStyle screen
The FreeStyle test screen provides you with flexible functionality that you can configure to create a wide variety of tests
for use in demonstrating and verifying hearing aid fitting and features.
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The FreeStyle screen
A. Snapshot Play button
B. 6 measurement buttons
C. Make Recording button

The FreeStyle Control Panel
The following table describes elements that are in the FreeStyle control panel, and not in other PMM test screens.
Snapshot Play button
Configure the signal, level and duration that will be played by the button.
Click the button to play the signal and to enable the Snapshot buttons.
See also Configuring the Snapshot Play button and the measurement buttons in FreeStyle
► 60.
Snapshot button
You can configure a measurement button to make a snapshot.
While the Snapshot Play button is playing a signal, click the Snapshot button to store a
measurement.
See also Using the Snapshot function ► 62.
Make Recording button
Click the button to begin recording.
When the recording is in progress, the button becomes a Stop button. Click the Stop button to stop the recording.
Configure a measurement button to play the recording. See also Using a recording as the
sound source ► 63.
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The Volume panel
Use the Mic. Sensitivity slider to control the input level when you make a recording.
Use the Master slider to control the output level when you play a CD.

For more information, see Using FreeStyle to create your own tests ► 59.

5.8

On Top mode in PMM
•

80

From any screen in PMM, you can activate On Top mode by clicking the On Top icon.

•

Move and scale the On Top window so that you can access the hearing instrument parameters in the fitting software,
and at the same time make use of the tests in PMM. You can also change the settings so that the left and right graphs
swap positions if necessary.

•

The position and size of the On Top window is automatically saved for the duration of the current session. The settings
for monaural and binaural views are saved separately.
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If you want to save the current settings as your default startup settings, in the Options window, click Save as Startup
Settings.

Hint: If you need to change the position or size of the On Top window depending on which fitting application you are
using, you can save a user test setup for each fitting application by clicking Save User Test in the Options window.
For more information about saving settings, see the Getting started with Otosuite section in the Otosuite Reference
Manual.

Switching between test screens
To switch between test screens in PMM (for example from Unaided Response to Noise Reduction), click the drop-down
button in the toolbar and select the test screen that you want to view in On Top mode.

Using the Control Panel in On Top mode
To show or hide the control panel in On Top mode, click the Show Control Panel button in the On Top toolbar.

Returning to normal viewing
To return to normal viewing, click on the Return to Normal View icon in the top right corner of the On Top window.
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Service, Cleaning and Maintenance

6.1

Equipment failure
Warning • Do not use a defective device.

If you believe the correct function or operation safety of FreeFit to be faulty in any way, disconnect FreeFit from the power
supply, remove the batteries, and make sure that it cannot be used by others until it has been serviced.

Warning • Under no circumstances disassemble FreeFit or the FreeFit charger. Contact your supplier.

6.2

Service and repair
Warning • Under no circumstances disassemble Aurical FreeFit or the Aurical FreeFit charger. Contact your
authorized service personnel. Parts inside Aurical FreeFit and the Aurical FreeFit charger must only be checked or serviced by authorized personnel.

Warning • Do not disassemble the FreeFit charger as there is a risk of electric shock.

Warning • For the sake of safety and in order not to void the warranty, service and repair of electro-medical
equipment should be carried out only by the equipment manufacturer or by service personnel at authorized workshops. In case of any defects, make a detailed description of the defect(s) and contact your supplier. Do not use a
defective device.

The manufacturer reserves the right to disclaim all responsibility for the operating safety, reliability and performance of
equipment serviced or repaired by other parties. Following repair, the equipment should be tested by suitably qualified
personnel.

6.2.1

Test device information
To see information relating to the test device, select Help > About FreeFit...
If FreeFit is not connected, click Connect.
A screen will show you specifics relating to Bluetooth version, COM port, hardware version, etc.
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6.3

Cleaning
Aurical FreeFit
Aurical FreeFit and its component parts are in constant contact with your patients so care should be taken to ensure that
they are kept clean and free from dust.
•

Use a soft, slightly damp cloth with a small amount of mild detergent or approved non-caustic medical grade disinfectant wipes to clean the unit and charger according to local infection control regulations.

Warning • Keep the unit away from liquids. Do not allow moisture inside the unit. Moisture inside the unit can
damage the instrument and it may result in a risk of electrical shock to the user or patient.

Warning • Never immerse the Aurical FreeFit probes into water or other cleaning solutions.

Note • No part of Aurical FreeFit or its accessories is suitable for autoclaving or thermal disinfection/sterilization methods.

Probe tubes, tube guides and ear cords or ear hooks
These parts are in constant contact with your patients.
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Probe with standard accessories

Probe with enhancement accessories

A. Probe tube
B. Ear cord
C. Test tube guide

A. Probe tube
B. Ear hook
C. Test tube guide
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•

Probe tubes:
The only part which is inserted into the ear canal during PMM testing is the Probe tube. These tubes are single use,
and shall only be used once per patient.

•

Tube guides and ear cords or ear hooks:
Use a soft, slightly damp cloth with a small amount of detergent to clean the ear cords or ear hooks and the tube
guides.

Disposal
There are no special requirements regarding the disposal of the silicone probe tubes, i.e. they can be discarded according
to local regulations.

6.4

Maintenance
Aurical FreeFit and the Aurical FreeFit charger unit require no preventive maintenance.

6.4.1

Annual replacement of the rechargeable battery
Replace the rechargeable battery with a new rechargeable battery (part number 031814) every year. For more information, see Inserting the battery ► 12

6.4.2

Calibration
FreeFit and the FreeFit probes are calibrated at the factory.
•

The probe calibration values for the reference microphone are saved in the probe assembly and follow the probe.
Accordingly, it is not necessary to keep track of left and right probes. A probe can be plugged into any FreeFit and
used right away.

Annual calibration
FreeFit and the FreeFit probes must be calibrated once a year by your authorized service department.

6.4.3

Replacing a probe
Disconnecting the probe from FreeFit
•

Disconnect the probe from FreeFit. Grip the probe cable by the plug and free it by gently pulling it out of the socket.
Do not pull the plug by the cable.

Connecting the probe to FreeFit
•

Aurical FreeFit

Insert the probe plug of the new probe in the probe socket on the side of FreeFit. The arrow stamped on the plug
must face outwards when you insert the plug.
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A. Probe plug in socket
B. Arrow

6.4.4

Replacing an ear cord
The ear cords are mounted at the factory. If you need to replace an ear cord:
• Remove the old cord, if required.
•

6.4.5

Mount the new ear cord on the probe. To do so, pull on the rubber cord and slide it into the groove.

Attaching an ear hook to the probe
Ear hooks provide a more stable positioning of the ear probe.
Before you can attach an ear hook to the probe, you must first replace the ear cord holder with the ear hook holder.
1. Remove the screw that holds the ear cord holder on the probe.
2. Position the ear hook holder with the rounded side towards the probe.
3. Use the screw to fasten the ear hook holder into position.
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4. Insert the ear hook into the holder and adjust the position of the hook.
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Unpacking and installing FreeFit and PMM
To install and get started with FreeFit and the Otosuite PMM module, follow the sequence below:
•

Install Otosuite. For Otosuite installation instructions, see the Otosuite Installation Guide, on the Otosuite installation
medium.

•

Unpack FreeFit. See Unpacking FreeFit ► 90.

•

Assemble FreeFit. See Assembling FreeFit and the FreeFit charger and ear probes ► 95.

•

Connect the cables of the test equipment.

•

Make sure FreeFit has fully charged batteries.

•

Run the PMM Configuration Wizard to connect to and set up communication with FreeFit. See Configuring PMM ►
105.

Note • This manual describes the assembly and use of the type 1053 charger unit. If you use the AURICAL speaker unit
to charge your FreeFit, see the Aurical® Aud manual.

7.1

Requirements to the location
A sound cabin or sound treated room is not necessary, but it is recommended that you use a room where reverberation
time is not too long.
To ensure safe performance, FreeFit must be correctly installed and the requirements listed in Safety - Aurical FreeFit and
PMM ► 111 and Technical Specifications - Aurical FreeFit ► 121 must be complied with.
If you use the AURICAL speaker unit to charge your FreeFit, see the Aurical® Aud manual, Standards and Safety and Technical Specifications - Aurical® Aud.

Warning • Always keep the charger cradle away from the patient area.

Caution • Keep FreeFit away from all liquids and sources of heat. For detailed specifications, see Technical Specifications - Aurical FreeFit ► 121.

7.1.1

Requirements to noise in the test environment
PMM testing does not require a quieter testing environment than do other traditional Real Ear Measurement systems.
Although PMM testing is designed for use in a regular dispensing office environment, the test environment should in some
cases be adapted to suit the specific test types.
•

Make sure that the test environment is as quiet as possible. The quieter the room is, the more accurate your testing
will be.
It is very important that the measurements are not influenced by sounds or noise relating to anything else than the
presented test signals. Measurements of peak levels will be influenced by any sounds louder than the presented test
signals. Even extremely brief sounds may impact the measurements.
It is therefore important that the environment is well controlled to prevent any unforeseen influence.

Aurical FreeFit

89

7 Unpacking and installing FreeFit and PMM

•

7.2

Check that testing is not being done under an air conditioner or in front of a fan or ventilator.

Unpacking FreeFit
1. Unpack the device carefully.
When you unpack the device and accessories, keep the packing material in which they were delivered. If you need to
send the device in for service, the original packing material will protect against damage during transport.
2. Visually inspect the equipment for possible damage.
If damage has occurred, do not put the device into operation. Contact your local distributor for assistance.
3. Check with the packing list to make sure that you have received all necessary parts and accessories. If your package is
incomplete, contact your local distributor.

7.3

Storing FreeFit
If you need to store FreeFit before you put it into operation, follow the guidelines below:
• Store FreeFit and accessories in the box provided to protect the equipment from damage.
•

7.4

Store FreeFit in a dry environment. See also Technical Specifications - Aurical FreeFit ► 121.

Views of FreeFit, the FreeFit charger and the ear probes
FreeFit is designed to be placed around the shoulders of the patient. It consists of a main unit and two REM probes which
are supplied with the unit. When not in use, it should be placed either on its desktop or wall-mounted charger.
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7.4.1

Front view

Aurical FreeFit

A.
B.
C.
D.

Device
Probes
Charger
Charger base plate

A.
B.
C.
D.
E.

Battery compartment
Status indicator
Power button
Probe
Ear cord
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With Probe Enhancement accessories
A.
B.
C.
D.
E.

7.4.2

Battery compartment
Status indicator
Power button
Probe
Ear hook

Reverse side view
A. Label
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7.4.3

The charger

Aurical FreeFit

Front view

Rear View

A. Charger tab for charging the device
B. Power indicator
C. Base plate

A. Charger socket
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7.4.4

The probes
With standard probe accessories
A.
B.
C.
D.
E.
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Connector
Probe body
Silicone probe tube
Probe tube guide
Cord
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With Probe Enhancement accessories
A.
B.
C.
D.
E.

7.5

Assembling FreeFit and the FreeFit charger and ear probes
•

7.5.1

Connector
Probe body
Silicone probe tube
Probe tube guide
Ear hook

Read the Otosuite manual before you connect or use FreeFit for the first time.

Charger assembly
Mount the charger on the base plate. You can choose between:
• Base plate assembly ► 95
•

Wall mount installation ► 98

For use with NOAHlink, see:
• Mounting the NOAHlink charger on the FreeFit charger base plate ► 98

Base plate assembly
Mount the charger on the charger base as shown below. This procedure applies both to desktop and wall mounting solutions.
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1. Use the hexagonal key to screw the hexagonal screws into place
as shown.
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2. Make sure that you tighten the screws well so that the charger
is stable when you place FreeFit on the charger.
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Wall mount installation
1. Drill 2 x 6 mm diameter holes 110 mm (4.33 inches) apart.
2. Insert rawlplugs.
3. Fit the screws through the back plate of the wall mount.

A. Locations for mounting 2 rawlplugs, 110 mm (4.33 inches)
B. Wall mount back plate

7.5.2

Mounting the NOAHlink charger on the FreeFit
charger base plate
If you plan to use FreeFit with NOAHlink (HIMSA’s product for hearing instrument fitting), you can attach NOAHlink to
FreeFit.
Start by mounting the NOAHlink charger on the base plate of the FreeFit charger. The FreeFit charger is delivered with a
power adapter and a Y-splitter cable that can be attached to the power adapter. This allows you to charge both FreeFit and
NOAHlink at the same time with a single power supply.
To mount the NOAHlink charger on the base plate of the FreeFit charger:
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1. Fix the mounting pads supplied with
FreeFit on the bottom of the NOAHlink
charger.
2. Remove the protective foil from the two
adhesive pads and carefully place the
NOAHlink charger on the FreeFit base
plate as shown.
For testing purposes you can fit NOAHLink on
the FreeFit shoulder strap. See Fitting FreeFit
with NOAHlink ► 101.

7.5.3

FreeFit and probe assembly
FreeFit is designed for easy attachment of the probe(s) used during the test.

Fitting silicone test tubes on the probes
A bag of silicone probe tubes is supplied together with Aurical FreeFit. The silicone test tube is used for probe microphone
measurement, where it is inserted into the ear canal together with the hearing instrument. The silicone test tube has a
black marker ring for marking how far into the ear canal the tube should be inserted.

Probe with standard accessories

A.
B.
C.
D.

Aurical FreeFit

Probe tube port
Marker ring
Ear cord
Probe tube support

E. Probe tube
F. Transducer tube port (RECD probe only)
G. Probe housing. Use the ruler to adjust
the marker ring on the tube.
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Probe with enhancement accessories

A.
B.
C.
D.

Probe tube port
Marker ring
Probe tube support
Ear hook

E. Probe tube with millimeter markings
F. Transducer tube port (RECD probe only)
G. Probe housing

1. Fit a probe tube to the probe tube port (thin metal tube) at the top of the probe housing. Gently push and twist the
probe tube down as far as possible over the port.
It is much easier to fit and remove the silicone test tube if you twist it gently. When you do so, make sure that you
hold the probe by the probe housing and not by the cable.

Note • Accurate testing is only guaranteed if you use the silicone test tubes designed specifically for FreeFit by
Natus.

2. Repeat for the second probe housing, if required.
3. A tube guide can be attached to each probe. The tube guide is designed to hold the silicone test tube in place in the
ear. Five tube guides are supplied with FreeFit.
The tube guide is easy to remove or replace: Grasp the tube guide by the base and pull.
4. To adjust the ear cord or ear hook simply pull to correct length for a comfortable fit over the patient’s ear.

A. Ear cord

A. Ear hook

5. Repeat for the second probe housing, if required.

Fitting the probes on the FreeFit shoulder strap
When the probes are not fitted on the ears of the patient, they are best kept on the shoulder strap of FreeFit for safe keeping.
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1. Place FreeFit face up.
2. With the ear cord or ear hook facing downwards, slide the probe housing into the grooves at the end of the shoulder
strap.
3. Repeat for the second probe housing, if needed.
A. Grooves
B. Probe

4. To remove the probe housing, simply pull it out of the grooves.

7.5.4

Fitting FreeFit with NOAHlink
If you use FreeFit with NOAHlink (HIMSA’s product for hearing instrument fitting), attach NOAHlink to FreeFit. See the following description.
When FreeFit and NOAHlink are not in use, they should each be placed in their charger cradle for charging. You can mount
the NOAHlink charger on the FreeFit charger. See Mounting the NOAHlink charger on the FreeFit charger base plate ►
98.
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Fitting NOAHlink

To attach NOAHlink to FreeFit, do as follows:
1. Remove the NOAHlink neck string from NOAHlink.
2. Attach the blue and red NOAHlink plastic attachment buttons on the end of the NOAHlink strap to NOAHlink.

Adjusting the NOAHlink straps
The length of the NOAHlink strap can be adjusted, if required. To adjust the length of the strap, pull the string loop to
loosen the string and then pull at either the end of the string or NOAHlink until the length is appropriate.
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A. Side view
B. Push string up through hole from below
C. Pull on short end of string to tighten

7.5.5

Fitting FreeFit with counterweights
If you use FreeFit without NOAHlink, attach the counterweights to FreeFit. See the following description. This will balance
the weight of FreeFit when it is placed on the shoulders of the patient, to keep it from sliding off.
1. Place FreeFit facing downwards.

A. Counterweight
B. Grooves

2. Slide the counterweight into the grooves at the
end of the shoulder strap.

A. Counterweight

3. Repeat with the second counterweight.

Removing the counterweights
•

7.6

To remove the counterweight, simply lift it out of the grooves.

Communication with PMM via Bluetooth
Communication via Bluetooth is established automatically from PMM, when you wish to use FreeFit. To set up the connection between PMM and FreeFit, you must run the PMM Configuration Wizard. For more information, see Configuring
PMM ► 105.
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To set up the connection between FreeFit and Counseling & Simulations, you must run the Counseling & Simulations configuration wizard. For more information, see the AURICAL Visible Speech and the Counseling and Simulations Module
manual.

Note • FreeFit must be switched on to be able to communicate with PMM. See Switching FreeFit on or off ► 13.

Note • PMM cannot communicate with FreeFit while the device is placed in the charger and the power to the charger
is connected.
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Configuring PMM
The PMM configuration wizard guides you through the process of setting up PMM. You must run the configuration wizard
before you can use PMM and FreeFit for the first time. You can also use the wizard later to change specific settings, or for
example, to repair the connection between PMM and FreeFit.
1. Select Tools > Configuration wizard...
2. To connect your test device to PMM and set up module-specific functionality, click the Configure... button for PMM.
Select Your FreeFit
Connect to the device you
wish to use for testing.

1. Click on the device you wish to use.
–

If the device is not listed, check the check box My device is turned on and
ready to be found, and click on Search.

–

If you are using a Bluetooth device other than OTOair and you are having
problems connecting to a device that is included in the list, click on Repair.

–

If you continue to have connection problems, click Test to see the connectivity status. This may help you or the Natus support team to diagnose
connection problems..

2. A text states which Bluetooth connection is currently being used – the OTOair
dongle, Microsoft Bluetooth stack, Widcomm Bluetooth stack, or Unknown
Bluetooth stack. If an OTOair dongle is plugged in, it will always be used.
If you always want to use the OTOair dongle to connect to your FreeFit, select
the Use only OTOair for device connection check box. Then you will receive an
error message if the OTOair is not plugged in.
For more information, see the “Connecting wireless devices” section in the “Configuring OTOsuite” chapter, in the Otosuite manual.
3. Click Next to continue the configuration or Finish to return to the Applications
page of the configuration wizard.
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Sound Card Selection
Select your preferred sound devices
(front and rear speaker output, headphone output, microphone input,
speaker channel).

1. Select from the drop-down lists.
2. Click Next or Finish.

Note • It is possible to use a front speaker and a rear speaker in
FreeStyle. For all other screens in PMM, it is only possible to use one
speaker.

Note • If you are running Otosuite on a computer with Windows
XP, certain events such as warnings from Otosuite or other applications may cause sounds to be played by the default sound card
of your computer. To avoid undesired noises during testing:

1. Ensure that you have configured PMM to use a sound card

other than the default sound card.
2. Mute your computer’s default sound card, or disable the sound

for warnings and other events.

Test Type
In the Test Type dialog, select the test types that you want to use. If you remove
the check mark for a test type, it will be hidden in the Navigation panel and the
test tab will be removed.

RECD Configuration
If you select the Always make both the Ear and Coupler measurement check box,
you will be prompted to make a new coupler measurement the first time you make
an RECD measurement in a new session.

Specify Calibration Frequency
Select how often you would
like to receive a reminder to
perform room calibration.

1. Select the relevant interval, and then click Next or Finish.
A reminder will be displayed if the specified interval elapses between calibrations.

Start Room Calibration
Perform room calibration.

1. Check the check box My FreeFit is turned on and within reach, and then click
Next.
The calibration is performed, and then the calibration offset values are displayed.
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2. Click Finish to return to the Applications page of the configuration wizard.

Note • In order to use FreeFit with Speech Mapping in the Counseling and Simulations module, you must run the
Counseling and Simulations Configuration wizard. For more information, see the AURICAL Visible Speech and the
Counseling and Simulations Module manual.
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Troubleshooting

9.1

Powering problems

9.2

Problem

Possible cause

Solution

FreeFit does not power on even
though I press the power button.

•

The battery is inserted incorrectly.

•

•

The battery needs charging or
replacing.

Insert the battery correctly.
Charge the battery or fit FreeFit with a
new battery.

FreeFit powers off and cannot
power on even though I press
the power button.

•

The battery needs charging or
replacing.

•

Charge the battery or fit FreeFit with a
new battery.

The FreeFit status indicator does
not light up when I place FreeFit
in the charger.

•

The charger is not connected to
the power adaptor, or the power
adaptor is not connected to the
mains power supply.

•

Connect the power adaptor to the charger and to the mains supply.

The FreeFit battery lifetime is
very low even though the battery has been charged.

•

The battery is defective, maybe
because it is too old.

•

Fit FreeFit with a new rechargeable battery.

The FreeFit status indicator
changes from amber (charging)
to green (charging complete),
very soon after I place FreeFit on
the charger.

•

An Alkaline battery has been
inserted in FreeFit.

•

Fit FreeFit with a new battery.

•

No battery is fitted in FreeFit.

•

The battery is defective.

FreeFit connection problems when not using OTOair
For more information, see also Configuring PMM ► 105 and “Connecting wireless devices” in the “Configuring OTOsuite”
section of the Otosuite manual.
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Problem

Possible cause

Solution

FreeFit does not connect to PMM.

If the Bluetooth dongle is inserted in
the AURICAL speaker unit and the PC
was started while the speaker unit
was not powered on, then the
Bluetooth connection may not have
initialize properly.

1. Ensure that the speaker unit
power supply cable is plugged
into the mains outlet.
2. Restart the PC and then launch
Otosuite and PMM.

Note • If you unplug the speaker
unit often, then insert the
dongle in the PC instead of in
the speaker unit.
FreeFit does not connect to PMM,
when you switch between multiple
FreeFit devices.

•

This may be a COM port assignment problem. The COM port is
assigned by the Bluetooth stack.

1. In the Select Your FreeFit dialog,
select the relevant device and
then click the Repair button.

Note • If you are using multiple
devices, it is highly recommended that you use the OTOair
device for communication.
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Safety - Aurical FreeFit and PMM
This manual contains information, which must be followed to ensure the safe performance of the devices and software
covered by this manual. Local government rules and regulations, if applicable, should also be followed at all times.
This manual describes the use and operation of the type 1053 charger unit. If you use the AURICAL speaker unit to charge
your FreeFit, refer to the user manual for Aurical® Aud.

10.1

Definition of symbols
Symbol

Standards
Reference

Standard Title of Symbol

EU Medical
Device
Regulations
2017/745

REGULATION (EU) 2017/745 OF
THE EUROPEAN PARLIAMENT
AND OF THE COUNCIL of 5 April
2017 on medical devices, amending Directive 2001/83/ EC, Regulation (EC) No 178/2002 and
Regulation (EC) No 1223/2009
and repealing Council Directives
90/385/ EEC and 93/42/EEC

Symbol Title as
per Referenced
Standard
CE marking

Explanation

(43) ‘CE marking of conformity’ or ‘CE marking’ means
a marking by which a manufacturer indicates that a
device is in conformity with
the applicable requirements
set out in this Regulation and
other applicable Union harmonisation legislation providing for its affixing
Notified Body number: 0459
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ISO 152231:2016
Reference
no. 5.1.1
(ISO 70003082)

Medical devices — Symbols to be
used with medical device labels,
labelling and information to be
supplied.

Manufacturer

Indicates the medical device
manufacturer.

ISO 152231:2016
Reference
no. 5.1.3.
(ISO 70002497)

Medical devices — Symbols to be
used with medical device labels,
labelling and information to be
supplied – Part 1: General
requirements.

Date of manufacture

Indicates the date when the
medical device was manufactured.

ISO 152231 Reference
no. 5.1.5

Medical devices — Symbols to be
used with medical device labels,
labelling and information to be
supplied.

Batch or Lot code

Indicates the manufacturer's
batch code so that the batch
or lot can be identified.

ISO 152231 Reference
no. 5.1.6

Medical devices — Symbols to be
used with medical device labels,
labelling and information to be
supplied.

Catalogue number

Indicates the manufacturer’s
catalogue number so that the
medical device can be identified.
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ISO 152231:2016
Reference
no. 5.1.7.
(ISO 70002498)

Medical devices — Symbols to be
used with medical device labels,
labeling, and information to be
supplied – Part 1: General
requirements.

Serial number

Indicates the manufacturer's
serial number so that a specific medical device can be
identified

N/A

N/A

Quantity

Indicates the quantity

ISO 152231:2016
Reference
no. 5.3.1.
(ISO 70000621)

Medical devices — Symbols to be
used with medical device labels,
labeling, and information to be
supplied – Part 1: General
requirements.

Fragile, handle
with care

Indicates a medical device
that can be broken or damaged if not handled carefully

ISO 152231:2016

Medical devices — Symbols to be
used with medical device labels,
labeling, and information to be
supplied – Part 1: General
requirements.

Keep dry

Indicates a medical device
that needs protection from
moisture

ISO 152231 Reference
no. 5.3.7
(ISO 70000632)

Medical devices —Symbols to be
used with medical device labels,
labelling and information to be
supplied.

Temperature limitations

Indicates the temperature limits to which the medical
device can be safely exposed

ISO 152231:2016
Reference
no. 5.3.8.
(ISO 70002620)

Medical devices —Symbols to be
used with medical device labels,
labelling and information to be
supplied.

Humidity limitations

Indicates the range of
(storage) humidity to which
the medical device can be
safely exposed.

ISO 152231:2016
Reference
no. 5.3.9
(ISO 70002621)

Medical devices — Symbols to be
used with medical device labels,
labeling, and information to be
supplied – Part

Atmospheric pressure limitation

To indicate the acceptable
upper and lower limits of
atmospheric pressure for transport and storage.

Reference
no. 5.3.4.
(ISO 70000626)

1: General requirements.

Keep away from
rain

ISO 15223 Keep dry
ISO 7000 Keep away from rain

ISO 15223 Atmospheric pressure limitation
ISO 7000 Atmospheric Pressure limitation
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ISO 152231:2016
Reference
no. 5.2.8.
(ISO 70002606)

Medical devices —Symbols to be
used with medical device labels,
labelling and information to be
supplied.

Do not use if pack- Indicates a medical device
age is damaged
that should not be used if the
package has been damaged or
opened and that the user
should consult the instructions for use for additional
information

ISO 152231:2016

Medical devices — Symbols to be
used with medical device labels,
labeling, and information to be
supplied – Part 1: General
requirements.

Do not re-use

ISO 152231:2016 and
ISO 152231:2020
Reference
no. 5.4.3.
(ISO 70001641)

Medical devices — Symbols to be
used with medical device labels,
labelling and information to be
supplied.

Consult instrucIndicates the need for the
tions for use Oper- user to consult the instrucator's manual;
tions for use
operating instructions

ISO 152231 Clause
5.4.4

Medical devices — Symbols to be
used with medical device labels,
labelling and information to be
supplied.

Caution: Read all
warnings and precautions in
instructions for
use

Indicates the need for the
user to consult the instructions for use for important cautionary information such as
warnings and precautions that
cannot, for a variety of reasons, be presented on the medical device itself.

General warning
sign

Indicates the need for the
user to consult the instructions for use for important cautionary information such as
warnings and precautions that
cannot, for a variety of reasons, be presented on the medical device itself.

Reference
no. 5.4.2.
(ISO 70001051)

IEC 60601-1
Table D.1
Symbol 10

IEC 606011, Table D.2
symbol 2

Aurical FreeFit

Medical electrical equipment —
Part 1: General requirements for
basic safety and essential performance.
Medical electrical equipment —
Part 1: General requirements for
basic safety and essential performance.

Indicates a medical device
that is intended for one single
use only
NOTE: Synonyms for “Do not
reuse” are “single use” and
“use only once”.
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ISO 152231:2016
Reference
no. 5.4.5.
(ISO 7000,
symbol
2025)

Medical devices —Symbols to be
used with medical device labels,
labelling and information to be
supplied.

Not made with
Natural Rubber
Latex

Indicates a medical device
that is not made with dry natural rubber or natural rubber
latex as a material of construction within the medical
device or the packaging of a
medical device

IEC 606011, Reference no.
Table D.2,
Symbol 20

Medical electrical equipment —
Part 1: General requirements. for
basic safety and essential performance

Type BF Applied
Part

To identify a type BF applied
part complying with IEC
60601-1.

EC 60601-1,
Reference
no. Table
D.2, Safety
sign 10 (ISO
7010M002)

Medical electrical equipment —
Part 1: General requirements for
basic safety and essential performance.

Follow instructions for use

Refer to instruction manual/
Booklet.

ISO 7000

Graphical symbols for use on
equipment - registered symbols

This way up

N/A

Directive
2012/19/EU

Waste Electrical and Electronic
Equipment (WEEE)

Disposal at end of
operating life
instructions

Indicates that electrical and
electronic waste equipment
waste should not be discarded
together with unseparated
waste but must be collected
separately.

-

-

An indication of
Medical device

The product is a medical
device.

21 CFR Part
801.109(b)
(1)

Labeling-Prescription devices.

Prescription only

Indicates the product is
authorized for sale by or on
the order of a licensed healthcare practitioner.

UL Listing

N/A

N/A

Nationally Recognized Testing
Laboratories (NRTL) certifications

(ICE 604175333)

Reference
no. 0623
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INMETRO
in conjunction
with UL for
Latin America

InMetro and UL marking of conformity

MEDICAL -General Medical
Equipment as to
electrical shock,
fire and mechanical hazards
only in accordance with:

INMETRO in conjunction with
the Mark of the National Institute of Metrology, Standardization and Industrial
Quality in Brazi

ANSI/AAMI
ES60601-1:2005/
(R)2012
IEC 60601-1-6
CAN/CSAC22.2No.
60601-1:14
CAN/CSAC22.2
No. 60601-1-6
China RoHS
2 Marking

N/A

N/A

Restriction of 6 hazardous substances for electronic and
electrical products sold in the
People’s Republic of China

N/A

Federal Communications Commission

21 CFR Part 15

Meets FCC requirements per
21 CFR Part 15 regulations
under which an intentional,
unintentional, or incidental
radiator may be operated
without an individual license.

ID: POOWMLC46

Unique identifier assigned to a
device registered with the
United States Federal Communications Commission
Module FCC ID certification
number: POOWML-C46
Int Powered

Aurical FreeFit

N/A

N/A

N/A

Internally Powered device,
uses battery.
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Disposal Instructions
Natus is committed to meeting the requirements of the European Union WEEE (Waste Electrical and Electronic Equipment) Directive 2012/19/EU. These regulations state that electrical and electronic waste must be separately collected for
the proper treatment and recovery to ensure that WEEE is reused or recycled safely. In line with that commitment Natus
may pass along the obligation for take back and recycling to the end user, unless other arrangements have been made.
Please contact us for details on the collection and recovery systems available to you in your region at www.natus.com.
Electrical and electronic equipment (EEE) contains materials, components and substances that may be hazardous and
present a risk to human health and the environment when WEEE is not handled correctly. Therefore, end users also have a
role to play in ensuring that WEEE is reused and recycled safely. Users of electrical and electronic equipment must not discard WEEE together with other wastes. Users must use the municipal collection schemes or the producer/importers takeback obligation or licensed waste carriers to reduce adverse environmental impacts in connection with disposal of waste
electrical and electronic equipment and to increase opportunities for reuse, recycling and recovery of waste electrical and
electronic equipment.
Equipment marked with the crossed-out wheeled bin is electrical and electronic equipment. The crossed-out wheeled bin
symbol indicates that waste electrical and electronic equipment should not be discarded together with unseparated waste
but must be collected separately.

10.2

General Warnings
Warning • Computer and printer must be placed out of reach of the patient, i.e. not closer than approx. 1.5
meters/5 ft.

Warning • Aurical FreeFit shall only be charged using the type 1053 charger unit or the type 1081 AURICAL
speaker unit from Natus.

Warning • Any PC connected to the device must comply with the requirements of IEC 62368-1:2020.

Warning • Make sure that users can easily disconnect the power supply cable from the back of the Freefit charger.

Warning • If you are using an alkaline battery, do not attempt to charge your Aurical FreeFit. Your alkaline battery may be damaged and leak, and this may in turn cause damage to Aurical FreeFit. Place FreeFit in the charger
unit only if Aurical FreeFit contains a rechargeable battery.

Warning • Do not store or operate the device at temperatures and humidity exceeding those stated in the Technical Specifications, Transport and storage.
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Warning • Refer to the guidance and manufacturer's declaration for electromagnetic emissions found in this
manual when installing and operating the device.

Warning • The Aurical FreeFit neckset includes a RF transmitter as indicated by the neckset device label.

Warning • There are no user-serviceable parts inside the cabinet of the device or charger. For the sake of safety
and in order not to void the warranty, service and repair of electro-medical equipment should be carried out only by
the equipment manufacturer or by service personnel at authorized workshops. In case of any defects, make a detailed
description of the defect(s) and contact your supplier. Do not use a defective device.

Warning • Avoid ElectroStatic Discharge (ESD) when installing the system. Install the unit in an environment that
minimizes the amount of static electricity. For example, anti-static carpeting is recommended.”

Warning • Do not use the instrument in the presence of flammable agents (gases) or in an oxygen-rich environment.

Warning • To avoid the risk of electric shock, this equipment must only be connected to a mains supply with protective ground.

Warning • This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not
installed and used in accordance with the instructions, may cause harmful interference to radio communications.
However, there is no guarantee that interference will not occur in a particular installation. If this equipment does
cause harmful interference to radio or television reception, which can be determined by turning the equipment off
and on, the user is encouraged to try to correct the interference by one or more of the following measures:
- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.

Warning • Keep the unit away from liquids. Do not allow moisture inside the unit. Moisture inside the unit can
damage the instrument and it may result in a risk of electrical shock to the user or patient.

Aurical FreeFit
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10.3

General cautions
Caution • Aurical FreeFit should only be provided with prescribed battery types, see .
Place the battery as indicated in the battery compartment.
Batteries should be removed if equipment is not likely to be used for some time.

Caution • Aurical FreeFit shall only be charged using the type 1053 charger unit or the type 1081 AURICAL
speaker unit from Natus.

Caution • Unless you are charging Aurical FreeFit with the Aurical® Aud speaker unit, which has a medically isolated power supply unit, do not attempt to use Aurical FreeFit with patients while it is placed in the charger unit.

Caution • No parts may be eaten, burnt, or in any way used for purposes other than the applications defined in
the Intended Use section of this manual.

Caution • Keep device away from heat sources.

Caution • The manufacturer reserves the right to disclaim all responsibility for the operating safety, reliability and
performance of equipment serviced or repaired by other parties. Following repair, a qualified electronics engineer
should verify the safety of all equipment.

Caution • To prevent cross-infection, use new eartips and probe tubes when you test the next patient.

Caution • This product is indicated for use by Audiologists, ENTs and other health care professionals or trained
personnel and should only be used on the patient target group.

Caution • Aurical FreeFit and Otosuite must always be installed in accordance with the instructions in the Aurical
FreeFit Reference Manual and User Guide and the Otosuite User Guide

Caution • The power supply should be kept away from the client area.
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Caution • The device and any device to be connected which has its own power supply should be turned off before
any connections are established. To disconnect the device from the mains supply, pull the mains plug out of the
wall mains outlet. Do not position the unit so that it is difficult to pull the mains plug out of the wall mains.

Caution • Changes or modifications not expressly approved by the manufacturer could void the user's authority to
operate the equipment.

10.4

General notes
Note • Do not use autoclaving or thermal disinfection or any sterilization methods on Aurical FreeFit and its accessories.

Note • Replace original ear cords with ear hooks for more stability of probes and probe tubes.

Note • The Probe Tube Assistant can only be used for placing probe tubes in unoccluded ears.

Note • The software provides option to hide patient information from a report (such as name, and social security number).

Note • For safety reasons and due to effects on EMC, accessories connected to the equipment's outlet fittings must be
identical to the type supplied with the system. Refer to the Power supply section in Technical specifications for more
information.

Note • Annual calibration must be performed on accessories containing transducers. Furthermore, it is recommended
that calibration be performed if the equipment has suffered any potential damage.

10.5

Manufacturer
Natus Medical Denmark ApS
Hoerskaetten 9, 2630 Taastrup
Denmark
+45 45 75 55 55
www.natus.com

Aurical FreeFit
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Responsibility of the manufacturer
The manufacturer is to be considered responsible for effects on safety, reliability, and performance of the equipment only
if:
•

All assembly operations, extensions, re-adjustments, modifications or repairs are carried out by the equipment manufacturer or personnel authorized by the manufacturer.

•

The electrical installation to which the equipment is connected complies with the requirements specified in the Technical Specifications section of this manual.

•

The equipment is used in accordance with the instructions for use.

The manufacturer reserves the right to disclaim all responsibility for the operating safety, reliability and performance of
equipment serviced or repaired by other parties.
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Technical Specifications - Aurical FreeFit

11.1

Aurical FreeFit
Type identification
AURICAL FreeFit is type 1053 from Natus Medical Denmark ApS

Interface
Interface

Wireless Bluetooth data transfer to PC, version 2.0, + EDR, class 2 (10
meters/33ft).

Bluetooth
Bluetooth antenna:

Chip multilayer antenna for 2.4 GHz

Antenna gain:

2 dBi

Antenna impedance:

50 Ω

The device supports Bluetooth SIG standards and uses features and functions from connected peripherals such as displaying
the working status on the console from a Bluetooth connection.
The device with Bluetooth technology, which operates in the same spectrum range in the 2.400 GHz-2.4835GHz (ISM
band) as Classic Bluetooth technology, uses Bluetooth technology's 79 1-MHz wide channels. Within the channel, data is
transmitted using Gaussian frequency shift modulation (GFSK), similar to Classic Bluetooth's Basic Rate scheme. The bit rate
is 1 Mbit/s.

Power supply
Battery types:

Rechargeable, Ni-MH, AA (R6) 1.2V, 1 pc.(Use only rechargeable batteries supplied by Natus). Can also be used with Alkaline AA (R6) 1.5V, 1 pc.

Battery supply voltage:

Nom. 1.30 V,
Max. 1.65 V,

Min. start-up:

1.10 V (Measured with instrument load)

Min. when running:

1.00 V

Low battery indicator level:

When approximately 30 minutes of battery operating time remain.

Estimated typical battery operating
runtime:

5 hours of continuous use. (This is based on a typical use scenario. The actual
use can influence the battery operating time).

Charger unit

Note • This manual describes the assembly and use of the type 1053 charger unit. If you use the AURICAL speaker unit
to charge your FreeFit, refer to the technical specifications in the manual for Aurical® Aud.

Aurical FreeFit

121

11 Technical Specifications - Aurical FreeFit

Type identification
Charger unit is type 1053 Charger from Natus Medical Denmark ApS

Power supply
Nominal input voltage:

9 V DC

Min. input voltage:

6.5 V DC

Max. input voltage:

12 V DC

Max. power consumption while charging: 300 mA (at 9 V input voltage)
Max. power consumption when not char- 60 mA (at 9 V input voltage)
ging:

External power supplies
Power supply: BRIDGEPOWER CORP,
MENB1010A0903B01

Input voltage: 100-240 V AC, 50-60 Hz
Output voltage: 9 V DC, 1.10 A

Power supply: DONGGUAN SHILONG
Input voltage: 100-240 V AC, 50-60 Hz
FUHUA ELECTRONIC CO., LTD., UE08WCP- Output voltage: 9 V DC, 0.56 A
090056SPA
Power supply: DONGGUAN SHILONG
FUHUA ELECTRONIC CO., LTD.,
UES06WNCP-090060SPA

Input voltage: 100-240 V AC, 50-60 Hz
Output voltage: 9 V DC, 0.6 A

Use only the power supply provided with the device.

Operating environment
Mode of operation:

Continuous.

Temperature:

+15°C to +35°C (59°F to +95°F)

Relative humidity:

20% to 90%, non-condensing

Warm-up time:

< 1 min.

Atmospheric pressure:

70 kPa to 106 kPa

Operation at temperatures below -20°C or above +60°C may cause permanent damage.

Storage and handling
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Temperature:

-30°C to +60°C (-22°F to +140°F)

Rel. humidity:

10% to 90% (non-condensing)

Atmospheric pressure:

50 kPa to 106 kPa
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Dimensions
AURICAL FreeFit (HxWxD):

23 mm x 350 mm x 230 mm (0.91 x 13.7 x 9.1 inches)

Charger unit (HxWxD):

280 mm x 180 mm x 230 mm (11.4 x 7.1 x 9.1 inches) (with table plate mounted)
340 mm x 180 mm x 230 mm (13.8 x 7.1 x 9.1 inches) (with wall plate mounted)

Weight
AURICAL FreeFit:

0.180 kg/0.40 lb

Charger unit:

0.700 kg/1.54 lb

Essential performance
Aurical® FreeFit has no essential performance and accordingly, the applicable requirements are as stated in the following:
•

Basic safety as defined by IEC 60601-1

All information required by IEC 60601-1-2:2014, #5.2.2.1-#5.2.2.10 is available in the Aurical® FreeFit User Guide.

Standards
Real Ear Measurement:

EN 61669:2016 excluding Clause 6.5

Safety:

IEC 60601-1:2005+A1:2012, Internally Powered, Type BF,IPX0
EN 60601-1:2006+A1:2013, Internally Powered, Type BF, IPX0
ANSI/AAMI ES60601-1:2005 + A1:2012
CAN/CSA-C22.2 NO. 60601-1:14

EMC:

IEC 60601-1-2:2014 and EN 60601-1-2:2015
IEC 60601-1-2:2007 and EN 60601-1-2:2007

Radio Equipment:

ETSI EN 300 328 V2.1.1 (2016)

Accessories
Standard accessories and optional accessories may vary from country to country - please consult your local distributor.

Aurical FreeFit
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11.2
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Accessories
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Accessories
Standard accessories and optional accessories vary from country to country - please consult your local distributor.
Aurical FreeFitAccessories

Group/Family

Part number

Accessory Details

Probe

8-69-39203

1053 FreeFit REM probe

Probe

8-69-39205

1053 Freefit RECD Probe

Probe

8-69-39207

1053 PMM RECD Probe Short

Probe

8-69-39210

1053 PMM RECD Probe Bin Short

Charger

8-62-39303

1053 Charger for FreeFit cobalt blue

Software

8-49-75800

1052 Otosuite DVD

REM

8-62-61000

1053 REM Tube Kit with ruler

REM

8-62-39400

REM Tube, Blue Handle (50 pcs.)

REM

8-62-35100

REM Test tubes, 1.1mm (50 pcs.)

Optional items

Part number

Group/Family

Aurical FreeFit

Accessory Details

Miscellaneous

8-35-25710

1053 Freefit Carrying Case

Miscellaneous

1-12-50202

1053 Battery lid for FreeFit Cob Blue

Miscellaneous

1-12-60700

1053 Charger Wall Plate

Miscellaneous

8-35-24500

1053, ASM CHARGER BOTTOM PLATE

Miscellaneous

8-35-24400

WALL MOUNTING ACCESSORIES

Miscellaneous

8-69-39301

M5X16 Hex Screw Kit

Miscellaneous

8-35-34700

Velcro clips

Miscellaneous

8-62-60600

PMM Clip Kit for ANA

Miscellaneous

8-62-39901

1053, Freefit, Noahlink Straps

Miscellaneous

8-62-49000

1053 RECD Fitting Kit

Power supply

5-01-11200

Power supply, 9VDC, 560MA, UNIV

Power supply

8-71-88100

1053, ADAPTOR Y-SPLITTER CABLE

Power supply

031814

Battery, 1.2V, NiMh Rechargeable, Size
AA/LR6

Software license

8-49-93700

2074 ProbeTube Assistant License

Software license

8-49-90800

NOAH System 4 License

Headsets/microphones

2-18-04200

Headset Monitoring

Headsets/microphones

2-18-04100

Headphone (customer)

Headsets/microphones

8-72-26610

1066 Microphone

Probes

8-62-60800

Probe Tube Holder mk2

Probes

8-62-61200

Ear Hook Upgrade Kit

Probes

1-21-69300

Rubber band for REM probe

Communication device

8-62-64900

1053 Otoair 2 Bluetooth Dongle
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11.3

Notes on EMC (Electromagnetic Compatibility)
•

Aurical FreeFit is part of a medical electrical system and is thus subject to special safety precautions. For this reason,
the installation and operating instructions provided in this document should be followed closely.

•

Portable and mobile high-frequency communication devices, such as mobile phones, may interfere with the functioning of Aurical FreeFit.

IEC 60601-1-2:2014 and EN 60601-1-2:2015
Guidance and manufacturer's declaration - electromagnetic emissions for all equipment and systems
Aurical FreeFit is intended for use in the electromagnetic environment specified below. The user of Aurical FreeFit should ensure that it is used in such an environment.
Emissions test

Compliance

Electromagnetic environment - guidance

RF emissions

Group 1

Aurical FreeFit uses RF energy only for its internal function. Therefore, its RF emissions are very

CISPR11
RF emissions

low and are not likely to cause any interference in nearby electronic equipment.
Class B

CISPR11

Aurical FreeFit is suitable for use in all environments, including domestic environments and those
directly connected to the public low-voltage power supply network that supplies buildings used
for domestic purposes.

Harmonic emissions IEC

Not applicable

61000-3-2
Voltage fluctuations/flicker

Not applicable

emissions IEC 61000-3-3

Guidance and manufacturer's declaration - electromagnetic immunity for all equipment and systems
Aurical FreeFit is intended for use in the electromagnetic environment specified below. The user of Aurical FreeFit should ensure that it is used in such an environment.
Immunity test

IEC 60601

Compliance level

Electromagnetic environment - guidance

test level

126

Electrostatic discharge (ESD)

+/- 8 kV contact

+/- 8 kV contact

Floors should be wood, concrete or ceramic tile. If floors

IEC 61000-4-2

+/- 2 kV, +/- 4 kV,

+/- 2 kV, +/- 4 kV,

are covered with synthetic material, the relative humid-

+/- 8 kV, +/- 15 kV air

+/- 8 kV, +/- 15 kV air

ity should be at least 30 %.

Electrical fast transient/burst

+/- 2 kV for power supply lines

+/- 2 kV for power supply lines

Mains power quality should be that of a typical com-

IEC 61000-4-4

+/- 1 kV for input/output lines

+/- 1 kV for input/output lines

mercial or hospital environment.

Aurical FreeFit
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Surge

+/- 1 kV line(s) to line(s)

+/- 1 kV line(s) to line(s)

Mains power quality should be that of a typical com-

IEC 61000-4-5

+/- 2 kV line(s) to earth

Not applicable

mercial or hospital environment.

+/- 2 kV DC input line(s) to earth

Not applicable

+/- 1 kV DC input line(s) to line(s)

+/- 1 kV DC input line(s) to line(s)

+/- 2 kV I/O line(s) to earth

Not applicable

Voltage dips, short inter-

0 % U ; 0.5 cycle

0 % U ; 0.5 cycle

ruptions and voltage vari-

At 0°, 45°, 90°, 135°, 180°, 225°, 270° At 0°, 45°, 90°, 135°, 180°, 225°, 270° mercial or hospital environment. If the user of the Aur-

T

T

Mains power quality should be that of a typical com-

ations on power supply input and 315°

and 315°

ical FreeFit requires continued operation during power

lines

0 % U ; 1 cycle

0 % U ; 1 cycle

mains interruptions, it is recommended that the Aurical

IEC 61000-4-11

and

and

FreeFit be powered from an uninterruptible power sup-

T

power supply input lines

ply or a battery.

70 % U ; 25/30 cycles

70 % U ; 25/30 cycles

Single phase: at 0°

Single phase: at 0°

0 % U ; 250/300 cycles

0 % U ; 250/300 cycles

30 A/m

No relevant ports that could be

Power frequency magnetic fields should be at levels char-

affected

acteristic of a typical location in a typical commercial or

T

Voltage interruptions on

T

T

T

T

IEC 61000-4-11
Power frequency
(50/60 Hz) magnetic field
IEC 61000-4-8
U

hospital environment.

T is the AC mains voltage prior to application of the test level.

Guidance and manufacturer's declaration - electromagnetic immunity - for equipment and systems within Professional Healthcare use environment
Aurical FreeFit is intended for use in the electromagnetic environment specified below. The user of Aurical FreeFit should ensure that it is used in such an environment.
Immunity test

IEC 60601

Compliance level

Electromagnetic environment - guidance

test level

Aurical FreeFit

Conducted RF

3 V rms

3 V rms

IEC 61000-4-6

150 kHz to 80 MHz

150 kHz to 80 MHz

6 V rms

6 V rms

ISM Bands and Amateur

ISM Bands and Amateur

Radiated RF

10 V/m

10 V/m

IEC 61000-4-3

80 MHz to 2.7 GHz

80 MHz to 2.7 GHz

3 V/m

3 V/m

80 MHz to 2.7 GHz

80 MHz to 2.7 GHz
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Proximity fields from RF wire- 27 V/m

27 V/m

Separation distance between any electronic parts of Aur-

less communications

385 MHz

385 MHz

ical FreeFit and any RF wireless communication equip-

28 V/m

28 V/m

450 MHz

450 MHz

9 V/m

9 V/m

710 MHz, 745 MHz, 780 MHz

710 MHz, 745 MHz, 780 MHz

28 V/m

28 V/m

810 MHz, 870 MHz, 930 MHz

810 MHz, 870 MHz, 930 MHz

28 V/m

28 V/m

1720 MHz, 1845 MHz, 1970 MHz

1720 MHz, 1845 MHz, 1970 MHz

28 V/m

28 V/m

2450 MHz

2450 MHz

9 V/m

9 V/m

5240 MHz, 5500 MHz, 5785 MHz

5240 MHz, 5500 MHz, 5785 MHz

IEC 61000-4-3

ment must be more than 30 cm (11.8 inches).

Note 1: At 80 MHz and 800 MHz the separation distance for the higher frequency range applies.
Note 2: These guidelines may not apply in all situations. Electromagnetic propagation is affected by absorption and reflection from structures, objects and
people.

IEC 60601-1-2:2007 and EN 60601-1-2:2007
Guidance and manufacturer's declaration - electromagnetic emissions for all equipment and systems
Aurical FreeFit is intended for use in the electromagnetic environment specified below. The user of Aurical FreeFit should ensure that it is used in such an environment.
Emissions test

Compliance

Electromagnetic environment - guidance

RF emissions

Group 1

Aurical FreeFit uses RF energy only for its internal function. Therefore, its RF emissions are

CISPR11

very low and are not likely to cause any interference in nearby electronic equipment.

RF emissions

Class B

Aurical FreeFit is suitable for use in all environments, including domestic environments and

CISPR11

those directly connected to the public low-voltage power supply network that supplies
buildings used for domestic purposes.

Harmonic emissions IEC 61000-3-2

Not applicable

Voltage fluctuations/flicker emissions IEC Not applicable
61000-3-3

Guidance and manufacturer's declaration - electromagnetic immunity for all equipment and systems
Aurical FreeFit is intended for use in the electromagnetic environment specified below. The user of Aurical FreeFit should ensure that it is used in such an environment.
Immunity test

IEC 60601

Compliance level

Electromagnetic environment - guidance

test level
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Electrostatic discharge (ESD)
IEC 61000-4-2

+/- 6 kV contact

+/- 6 kV contact

Floors should be wood, concrete or ceramic tile. If floors are covered with syn-

+/- 8 kV air

+/- 8 kV air

thetic material, the relative humidity should be at least 30 %.

Power frequency

3 A/m

3 A/m

Power frequency magnetic fields should be at levels characteristic of a typical loc-

(50/60 Hz) magnetic

ation in a typical commercial or hospital environment.

field
IEC 61000-4-8

Guidance and manufacturer's declaration - electromagnetic immunity - for equipment and systems that are NOT life-supporting
Aurical FreeFit is intended for use in the electromagnetic environment specified below. The user of Aurical FreeFit should ensure that it is used in such an environment.
Immunity test

IEC 60601

Compliance level

Electromagnetic environment - guidance

3 V/m

Portable and mobile RF communications equip-

test level
Radiated RF

3 V/m

IEC 61000-4-3

80 MHz to 2.5 GHz

ment should be used no closer to any part of Aurical FreeFit, including cables, than the
recommended separation distance calculated from
the equation applicable to the frequency of the
transmitter.
Recommended separation distance:
d = 1.2

for 80 MHz to 800 MHz

d = 2.3

for 80 MHz to 2.5 GHz,

where P is the maximum output power rating of
the transmitter in watts (W) according to the transmitter manufacturer and d is the recommended
separation distance in metres (m).
Field strengths from fixed RF transmitters, as
determined by an electromagnetic site survey, a
should be less than the compliance level in each
frequency range. b
Interference may occur in the vicinity of equipment marked with this symbol:

Note 1: At 80 MHz and 800 MHz the separation distance for the higher frequency range applies.
Note 2: These guidelines may not apply in all situations. Electromagnetic propagation is affected by absorption and reflection from structures, objects and
people.
a. Field strengths from fixed transmitters, such as base stations for radio (cellular/cordless) telephones and land mobile radios, amateur radio, AM and FM radio
broadcast and TV broadcast cannot be predicted theoretically with accuracy. To assess the electromagnetic environment due to fixed RF transmitters, an
electromagnetic site survey should be considered. If the measured field strength in the location in which Aurical FreeFit is used exceeds the applicable RF
compliance level above, the Aurical FreeFit should be observed to verify normal operation. If abnormal performance is observed, additional measures might
be necessary, such as reorienting or relocating Aurical FreeFit.
b. Over the frequency range 150 kHz to 80 MHz, field strengths should be less than 3 V/m.
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Recommended separation distances between portable and mobile RF communications equipment and Aurical FreeFit
The Aurical FreeFit is intended for use in an electromagnetic environment in which radiated RF disturbances are controlled. The customer or the user of the Aurical FreeFit can help prevent electromagnetic interference by maintaining a minimum distance between portable and mobile RF communications equipment
(transmitters) and the Aurical FreeFit as recommended below, according to the maximum output power of the communications equipment.
Rated maximum output power of transmitter

Separation distance according to frequency of transmitter

W

m
80 MHz to 800 MHz

800 MHz to 2.5 GHz

d = 1.2

d = 2.3

0.01

0.12

0.23

0.1

0.38

0.73

1

1.2

2.3

10

3.8

7.3

100

12

23

For transmitters rated at a maximum output power not listed above, the recommended separation distance d in meters (m) can be estimated using the equation applicable to the frequency of the transmitter, where P is the maximum output power rating of the transmitter in watts (W) according to the transmitter
manufacturer.

Note 1: At 80 MHz and 800 MHz the separation distance for the higher frequency range applies.
Note 2: These guidelines may not apply in all situations. Electromagnetic propagation is affected by absorption and reflection from structures, objects and
people.
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App. 1

Literature References

This appendix contains references to literature where you can find more information about fitting hearing instruments.

App. 1.1

General
For general information about fitting hearing instruments, see the following references:
British Society of Audiology and British Academy of Audiology; July 2007; Guidance on the use of real ear measurement

to verify the fitting of digital signal processing hearing aids.
Ching TYC; O’Brien A, Dillon H, Chalupper J, Hartley L, Hartley D, Raicevich G, Hain J; 2009; Directional Effects on Infants
and Young Children in Real Life: Implications for Amplification; Journal of Speech, Language, and Hearing Research Vol.
52, 1241–1254; © American Speech-Language-Hearing Association.
Cox RM; 2009; Verification and what to do until your probe-mic system arrives; The Hearing Journal Vol. 62, No. 9.
Hawkins DB, Cook JA; 2003; Hearing aid software predictive gain values: How accurate are they?; The Hearing Journal
Vol. 56, No. 7.
Hornsby BWY, Mueller HG; 2008; User Preference and Reliability of Bilateral Hearing Aid Gain Adjustments; Journal of
the American Academy of Audiology Volume 19, Number 2.
Lantz J, Jensen OD, Haastrup A, Olsen SO; 2007; Real-ear measurement verification for open, non-occluding hearing
instruments; International Journal of Audiology Volume 46 Number 1, 11-16.
Lindley GA, Palmer CV; 1997; Fitting Wide Dynamic Range Compression Hearing Aids: DSL [i/o], the IHAFF Protocol, and
FIG6; American Journal of Audiology Vol. 6 No. 3.
Mueller HG; 2009; A candid round table discussion on open-canal hearing aid fittings; The Hearing Journal Vol. 62, No.
4.
Mueller HG, Hornsby BWY, Weber JE; 2008; Using Trainable Hearing Aids to Examine Real-World Preferred Gain;
Journal of the American Academy of Audiology Volume 19, Number 10.
Mueller HG, Weber J, Hornsby BWY; 2006; The Effects of Digital Noise Reduction on the Acceptance of Background
Noise; Trends in Amplification Vol. 10, No. 2.
Mueller HG; 2001; Probe Microphone Measurements: 20 Years of Progress; Trends in Amplification Vol. 5, No. 2.
Palmer C; 2005; In fitting kids with hearing aids, ensuring safety and audibility is a good way to start; The Hearing
Journal Vol. 58, No. 2.
Rhebergen KS, Versfeld NJ; 2005; A Speech Intelligibility Index-based approach to predict the speech reception
threshold for sentences in fluctuating noise for normal-hearing listeners; Journal of the Acoustical Society of America
117 (4).
Ricketts TA, Mueller HG; 2009; Whose NAL-NL fitting method are you using? The Hearing Journal Vol. 62, No. 8.
Ricketts TA, Van Vliet D; 1996; Updating Our Fitting Strategies Given New Technology; American Journal of Audiology
Vol. 5 No. 2.

App. 1.2

Fitting prescriptions
For more information about the fitting prescriptions, see the following literature references:

DSL
DSL Clinical Protocols. Available from http://www.dslio.com.
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Literature References

Bagatto MP, Scollie SD, Seewald RC, Moodie KS, Hoover BM; 2002; Real-Ear-to-Coupler Difference Predictions as a Function of Age for Two Coupling Procedures; Journal of the American Academy of Audiology Volume 13, Number 8.
Bagatto MP, Seewald RC, Scollie SD, Tharpe AM; 2006; Evaluation of a Probe-Tube Insertion Technique for Measuring
the Real-Ear-to-Coupler Difference (RECD) in Young Infants; Journal of the American Academy of Audiology Volume 17,
Number 8.
Lewis DE, Stelmachowicz PG; 1993; Real Ear to 6-cm3 Coupler Differences in Young Children; Journal of Speech and Hearing Research Volume 36, 204-209.
Olsen WO; 1998; Average Speech Levels and Spectra in Various Speaking/Listening Conditions: A Summary of the Pearson, Bennett, & Fidell (1977) Report; American Journal of Audiology Vol. 7 1059-0889.
Scollie SD; 2007; DSL version v5.0: Description and Early Results in Children; Audiology Online; http://www.audiologyonline.com/articles/pf_article_detail.asp?article_id=1753.
Scollie SD, Seewald RC, Cornelisse L, Moodie KS, Bagatto MP, Laurnagaray D, Beaulac S, Pumford J; 2005; The Desired
Sensation Level Multistage Input/Output Algorithm; Trends In Amplification Volume 9, Number 4.
Seewald RC, Moodie KS, Sinclair ST, Scollie SD; Predictive Validity of a Procedure for Pediatric Hearing Instrument
Fitting; American Journal of Audiology Vol. 8 142-153; © American Speech-Language-Hearing Association; http://journals.asha.org.
Seewald RC, Scollie SD; 2003; An Approach for Ensuring Accuracy in Pediatric Hearing Instrument Fitting; Trends In
Amplification Volume 7, Number 1.
Tharpe AM, Sladen D, Huta HM, Rothpletz AM; 2001; Practical Considerations of Real-Ear-to-Coupler Difference Measures in Infants; American Journal of Audiology Vol. 10 41-49; © American Speech-Language-Hearing Association; http://journals.asha.org.

NAL-NL1
National Acoustic Laboratories Web site: http://www.nal.gov.au/
Ching TYC, Dillon H; 2003; Prescribing Amplification for Children: Adult-Equivalent Hearing Loss, Real-Ear Aided Gain,
and NAL-NL1; Trends in Amplification Volume 7, Number 1.
Ching TYC, Dillon H, Hill M, Britton L, Agung K; 2003; Prescribing and evaluating amplification for children: some problems and solutions; National Acoustic Laboratories Annual Report 2002-2003.
Keidser G, Brew C, Peck A; 2003; How proprietary fitting algorithms compare to each other and to some generic
algorithms; The Hearing Journal, March 2003.

App. 1.3

Speech Intelligibility Index (SII)
The Speech Intelligibility Index (SII) is calculated as defined by:
ANSI S3.5-1997 (R2002), "Methods for Calculation of the Speech Intelligibility Index".
For more information about SII, see also:
Hornsby BWY; 2004;The Speech Intelligibility Index: What is it and what’s it good for?; The Hearing Journal Vol. 57, No.
10.

App. 1.4

Fitting workflows
For more information about fitting workflows, see the following references:
American Academy of Audiology; October 2003; Pediatric Amplification Protocol.
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Literature References

American Speech-Language-Hearing Association. 2006. Preferred Practice Patterns for the Profession of Audiology; Available from www.asha.org/policy.
American Speech-Language-Hearing Association. 1998. Guidelines for Hearing Aid Fitting for Adults; Available from
www.asha.org/policy.
American Speech-Language-Hearing Association. 1994. Clinical Record Keeping in Audiology and Speech-Language Pathology; Available from www.asha.org/policy.
Colorado Infant Hearing Advisory Board and Membership of the Screening, Assessment, and Early Intervention Task Forces;
2000/2004; Colorado Infant Hearing Advisory Committee: Guidelines for Infant Hearing Screening, Audiologic Assessment, and Early Intervention.
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Glossary of Audiology Acronyms
Acronyms

Description

ABR

Auditory Brainstem Response

AC

Air Conduction

ACDC

Acoustic Coupling Difference Curve

AI

Articulation Index

ANSI

American National Standards Institute

ASSR

Auditory Steady-State Response

BC

Bone Conduction

BTE

Behind-The-Ear (hearing aid)

CIC

Completely-In-The-Canal (hearing aid)

DSL

Desired Sensation Level

eHL

Estimated Hearing Level

FC

Frequency Compression

FFT

Fast Fourier Transform

FM

Frequency Modulation

FSW

Fitting Software

HA1

Hearing Aid Coupler Type 1 (ITE Coupler)

HA2

Hearing Aid Coupler Type 2 (BTE Coupler)

HI

Hearing Instrument

HIM

Hearing instrument manufacturer

HIS

Hearing Instrument Simulator

HLa.e.

Adult Equivalent Hearing Level

HL

Hearing Level

HLS

Hearing Loss Simulator

IEC

International Electrotechnical Commission

ISO

International Organization for Standardization

ISTS

International Speech Test Signal

ITC

In-The-Canal (hearing aid)

ITE

In-The-Ear (hearing aid)

KEMAR

Knowles Electronics Mannequin for Acoustics Research

LTASS

Long Term Average Speech Spectrum
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Acronyms

Description

MCL

Most Comfortable Level

MPO

Maximum Power Output

NAL

National Acoustic Laboratories

nHL

Normalized Hearing Level

NL1

Non-linear version 1

NL2

Non-linear version 2

OES

Occluded Ear Simulator

PAA

Predicted Aided Audiogram

PMM

Probe Microphone Measurements

REAG/REAR

Real Ear Aided Gain/Response

RECD

Real Ear Coupler Difference

REDD

Real Ear Dial Difference

REIG/REIR

Real Ear Insertion Gain/Response

REM

Real Ear Measurement

REOG/REOR

Real Ear Occluded Gain/Response

REUG/REUR

Real Ear Unaided Gain/Response

SF

Sound Field

SII

Speech Intelligibility Index

SLM

Sound Level Meter

SPL

Sound Pressure Level

STASS

Short Term Average Speech Spectrum

TAA

Target Aided Audiogram

UCL

Uncomfortable Loudness Level

VC

Volume Control
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Index

Index
CD as sound source 63
Charger
A

assembly 95

Action 70
Aided response

desktop installation 95
first time charging 12
powering 11

configuring measurement buttons 36

views 93
wall mount installation 98

measuring 44
Aided Response test screen 76
Algorithm, DSL v 5.0a 29

Charging FreeFit 14
Client

Amplification 32

fitting FreeFit and probes for testing 20

Applied RECD 32

inspecting the ear 19

Alkaline batteries 12

preparing for testing 19

Applied REDD 35
Applied REUR/REUG 31
Assembly

Client Type in Fitting Details 34
Communication
Bluetooth 103

FreeFit 95

test devices, setting up 16

FreeFit base plate 95
FreeFit charger 95
FreeFit counterweights 103
FreeFit shoulder strap 100
FreeFit with NOAHlink 98, 101
FreeFit, wall mounted 98
probes 99

Compression in Fitting Details 34
Compression Speed in Fitting
Details 34
Compression Type in Fitting
Details 34
Configuration Wizard 105
copy

Base plate

button settings 38
Copy

assembly 95
Batteries

curves 49
Counterweights

B

FreeFit 103

Alkaline 12
battery low status, FreeFit 15
inserting in FreeFit 12

coupler based measurement 45
Curve legend
in PMM 48

NiMH 12

show/hide 72

rechargeable 12
Bluetooth communication 103

Curve resolution in PMM 41
Curves

C

copying 49

Calibration

deleting 49

annual c., FreeFit 85
FreeFit silicone test tubes 18

D

OpenREM 47

Date of birth in fitting details 31
Delete

preparing for tube c. 18
reference microphone 18

curves 49

speakers 17
Calibration, sound level 46
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Index

powering 11

Devices

powering status 14

setting up communication with
PMM 16

preparing for testing 17

DSL v 4.2 28

probe assembly 99

DSL v 5.0 29, 131

probes diagram 94
replacing probes 85

E

shoulder strap assembly 100

Experience in Fitting Details 33

storing 90
switching off 13

F
favorite signals list 61
Feature-to-Benefit view in
FreeStyle 42, 64, 73
Feedback 57
Feedback Finder in PMM 66
Finalize Measurement button 45-46

switching on 13
troubleshooting 109
views 90
FreeStyle (PMM) 59
FreeStyle control panel 79
FreeStyle test screen 78

Firmware update, test devices 16

G

Fitting Depth in Fitting Details 34

Gain view, selecting 71

Fitting details 29
Fitting details for a stored measurement 50
Fitting Mode 30
Fitting prescriptions
literature references 36, 131
select and configure 28
Fitting workflows, literature references 132
FM
advantage 64
transparency 64
FreeFit

Gender 31
Getting started
FreeFit 11, 89
Glossary, PMM 135
H
HI Compression Type 34
HI Type in Fitting Details 32
HL
selecting HL view 72
HL to SPL conversion 28
Hygienic precautions, PMM
testing 19

annual calibration 85
assembly 95

I

assembly with NOAHlink 98

Icons

assembly, wall mounted 98

Gain view 71

base plate assembly 95

graph selection 72

battery low status 15

HL or SPL view 72

charger assembly 95

PAA view 71

charging 14

Probe Tube Calibration 74

counterweight assembly 103

REIG view 71

equipment failure 83

Response view 71

first time charging 12
installation 95

show/hide curve legend 72
switch to Feature-to-Benefit
view 73

NOAHlink assembly 101

switch to On Top mode 73

inserting batteries 12
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Index

Installation
FreeFit 95
Intended use
AURICAL FreeFit 8
PMM Module 8

O
Occluded response (PMM) 57
Occluded Response test screen 76
On Top mode
activate 73
PMM 80

L
Language Type in Fitting Details 35
Legend
PMM 48

On/Off, FreeFit 13
OpenREM Calibration 47
Overlays box
PMM 38

show/hide 72
Legend box in PMM 48
Limiting in Fitting Details 34

P

Literature references 131
Live speech as sound source in
PMM 64
Long Term Average Speech
Spectrum 41

PAA view in PMM 78

LTASS curves 41

Percentile curves 41
PMM
On Top mode 80
PMM measurement buttons, configuring 36
Powering

M

battery status 14

Maintenance, FreeFit 83
Manufacturer

battery types 12
charger 11
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device 11

Maximum Power Output 37

FreeFit 11

Measurement, New 70
Microphone
reference m. calibration 18
Monitoring signal at ear drum 68
MPO 37
N
NAL-NL1 29, 132
New PMM 70
NiMH batteries 12
NOAHlink

problems, FreeFit 109
Powering off FreeFit 13
Powering on FreeFit 13
Powering status, FreeFit 14
Predicted Aided Audiogram view in
PMM 78
Predicted Aided Audiogram view,
selecting 71
Preparing for testing
fitting FreeFit and probes on the
client 20

adjusting straps 102

FreeFit 17

fitting on FreeFit 101

inspecting the client’s ear 19

installation 98
Noise
in the test environment 17
Noise reduction 57
Noise reduction in PMM,
configuring 58

preparing the client 19
Probe
assembly 99
fitting on client 20
replacement 85
tube calibration 18
view 94
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Index

Probe microphone
measurements 27
Probe tube calibration icon 74
Probe tube monitoring 68
Program type in Fitting Details 34

Screens
PMM On Top mode 80
Sequence of measurements in
PMM 45
Service and repair, FreeFit 83, 111
Shoulder strap

R

assembly 100

Real Ear Coupler Difference 51
RECD 51

Show Signal Spectrum 40
Signal

applying to both ears 54

favorites list 61

entering manually 55

from CD, PMM 63

measuring 51

from file, PMM 60

single probe 54

from recording, PMM 63

swapping measurements 55

live, PMM 64

RECD Type 35

monitoring at the ear drum 68

Rechargeable batteries 12

selecting source, PMM 60

Recording as sound source 63

Signal level and vocal effort 38

Reference audiogram 70

SII 49

Reference audiogram, selecting 27
Reference microphone

Snapshot mode 60, 62

calibration 18

Sound level calibration 46
Speakers

References, literature 131

calibration 17

REIG view, selecting 71
Renaming a measurement button in
PMM 37

Specifications, technical, FreeFit 121

REOG 57
Replacement

selecting SPL view 72
Status indicator, FreeFit

probes 85
Reports
in PMM 69
Response view, selecting 71
Restarting a PMM measurement 45

Speech Intelligibility Index 49
SPL

battery low status 15
powering status 14
Storing
FreeFit 90
Straps

REUG 55
REUG Orientation 35

Switching on FreeFit 13

S
Safety
AURICAL FreeFit 111
AURICAL FreeFit
manufacturer 119
AURICAL FreeFit symbols 111
AURICAL FreeFit warning
notes 116
FreeFit 111
PMM 111
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adjusting, NOAHlink 102
Switching off FreeFit 13

T
Target aided threshold 78
Target rules
configuring 29
DSL v 5.0 29
DSL v4.2 28
fitting details 29-30
NAL-NL1 29
selecting 29
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Index

Target Type in Fitting Details 35
Technical specifications, FreeFit 121
Test devices
connecting to 16
firmware update 16
information about 83
views 90
Test environment
PMM and FreeFit 17
Transducer in Fitting Details 33
Troubleshooting
FreeFit 109
Tube calibration 18
U
Unaided response (PMM) 55
Unaided Response test screen 76
Unpacking FreeFit 90
Use Bone Conduction 33
V
Venting Size 32
Verification Signal 36
Vocal effort 38
VU meter in PMM 48
W
Wall mounting
FreeFit 98
Warning notes
AURICAL FreeFit 116
Z
Zoom in PMM graphs 75
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